DOSI in novel geometry dishes

Jonathan Lawrence Lambert Jones

University of Louisville

Follow this and additional works at: https://ir.library.louisville.edu/etd

Part of the Chemical Engineering Commons

Recommended Citation
https://doi.org/10.18297/etd/1685
DOSI IN NOVEL GEOMETRY DISHES

By

Jonathan Lawrence Lambert Jones
B.S., University of Louisville, 2013

A Thesis
Submitted to the Faculty of the
University of Louisville
in Partial Fulfillment of the Requirements
for the Professional Degree

MASTER OF ENGINEERING

Department of Chemical Engineering

April 2015
ACKNOWLEDGEMENTS

First I would like to acknowledge my wife, Mandy Jones. She has helped me reach this point through her constant support, encouragement, and love. She is the love of my life and will share this success with me but more importantly has shared this journey with me.

Second, I would like to acknowledge my family, all ten of them (Adolphus, Tanya, Leah, Peachie, Samuel, Jefferson, Benjamin, Joseph, Joel, and Labrenda). Their encouragement over the years and help with editing were a life saver during the later writing sessions when it was a struggle to continue.

Third, I would be amiss if I didn’t thank all my classmates and professors over the years that taught me and helped me to grow. I wish them all, all the best, particularly, Lucas Spicer and Rima Patel.

Lastly, I acknowledge my committee for their knowledge and insights, Dr. Eric Berson, Dr. Keith Sharp, and Dr. James Watters. Especially to my advisor Dr. Eric Berson, who has remained patient with me and has provided wonderful guidance. This work would never have been completed without him.
ABSTRACT

Effects of hemodynamic forces on cellular response are well studied. Wall shear stress is regularly accepted as the primary hemodynamic force affecting cellular response. Hemodynamic forces studies utilize Petri dishes on orbital shakers to grow cells for the experiments since this is an easily scalable system. However, characterizing the hemodynamics is difficult since the oscillatory swirling motion creates multidirectional and variable magnitude shear throughout the dish. Thus, a novel geometry dish that could create uniaxial shear with less variation in magnitude would be advantageous for studying shear stress effects on cellular response.

The purpose of this thesis was to explore the ability for creating narrow shear ranges in terms of magnitude and direction, and to determine DOSI in novel geometry dishes. The new geometries consist of a narrow channel flat bottom dish and a narrow channel banked bottom dish. The study used computational fluid dynamics (Fluent) to simulate the fluid motion in the dishes. The study concluded with successfully identifying conditions surrounding regions of low variation of magnitude and direction of shear and DOSI patterns. For the NCF dish the least variation in shear magnitude, between radial locations, occurs at 60 RPM. In terms of the DOSI values, the NCF dish had increasingly higher DOSI values, meaning more uniaxial favored (tangential) flow across the surface of the dish as speed increased. The lowest variation occurred at 180 RPM. For the NCB dish the least variation in shear magnitude, between radial locations, occurred at 90 RPM. The NCB dish’s narrow range of shear stress is hypothesized to be the result of a more parallel fluid surface relative to the bottom surface of the dish. The NCB dish had DOSI values close to 1.0, meaning more uniaxial favored (tangential) flow, at the 80% and 90% radial locations for speeds between 120 and 180 rpm.
TABLE OF CONTENTS

APPROVAL PAGE ......................................................................................................................... ii
ACKNOWLEDGEMENTS ............................................................................................................... iii
ABSTRACT ......................................................................................................................................... iv
TABLE OF CONTENTS ..................................................................................................................... v
NOMENCLATURE ............................................................................................................................ vii
LIST OF TABLES .............................................................................................................................. viii
LIST OF FIGURES .......................................................................................................................... ix
I. INTRODUCTION .......................................................................................................................... 1
II. REVIEW OF RELATED LITERATURE .......................................................................................... 3
   A. Definition of Shear Stress ......................................................................................................... 3
   B. Experimental Determination of Shear Stress ........................................................................... 4
   C. Examples of Shear Studies using Orbital Shakers ................................................................. 5
   D. Computational Fluid Dynamics ........................................................................................... 7
   E. Types of Shear Stress ............................................................................................................. 10
   F. DOSI ........................................................................................................................................ 17
   G. Dimensionless Parameters .................................................................................................. 18
III. RESEARCH METHODS .......................................................................................................... 22
   A. Simulation Plan ...................................................................................................................... 22
   B. Software ................................................................................................................................ 25
   C. Create Dish in Fluent ............................................................................................................. 26
   D. Set-Up Fluent Case ................................................................................................................. 30
   E. Analyzing Data ..................................................................................................................... 38
IV. RESULTS AND DISCUSSION OF RESULTS ......................................................................... 39
   A. General Discussion ................................................................................................................. 39
   B. NCF Shear Stress Contours .................................................................................................. 41
   C. NCF Tangential vs Radial Plots ............................................................................................ 46
   D. NCF Trend Line Slopes ......................................................................................................... 47
   E. NCF DOSI Vs Location ......................................................................................................... 49
   F. NCB Shear Stress Contours .................................................................................................. 50
   G. NCB Tangential vs Radial Plots ............................................................................................ 56
NOMENCLATURE

\( a = \) cylinder radius or narrow channel gap width  
\( A_s = \) surface area  
\( d_c = \) characteristic dimension  
\( f = \) frequency of rotation  
\( F_r = \) Froude number  
\( F_s = \) shear force  
\( g = \) gravitational acceleration  
\( H = \) mean fluid height  
\( h = \) enthalpy  
\( M = \) mass  
\( R = \) orbital radius  
\( \text{Re} = \) Reynolds number  
\( S_i = \) entropy  
\( S_l = \) slope ratio  
\( S_m = \) source term for the addition of mass  
\( S_t = \) Stokes number  
\( u = \) velocity  
\( y = \) height  
\( \rho = \) fluid density  
\( \tau = \) shear stress  
\( \tau_w = \) wall shear stress  
\( \theta = \) angle of banked dish bottom relative to orbital platform  
\( \mu = \) fluid viscosity  
\( \nu = \) kinematic viscosity  
\( \omega = \) angular velocity
LIST OF TABLES

TABLE I – DIMENSIONLESS VARIABLES ................................................................. 25
TABLE II – SLOPES CORRESPONDING WITH PRIMARY AXIS RELATION TO TANGENTIAL/RADIAL DIRECTION ........................................................................................................ 97
TABLE III – NARROW-CHANNEL DISH SIZE AND TIME FOR STEADY STATE RUNS CHART PART 1 ......................................................................................................................... 106
TABLE IV – NARROW-CHANNEL DISH SIZE AND TIME FOR STEADY STATE RUNS CHART PART 2 ......................................................................................................................... 107
TABLE V – 73712 CELL NARROW CHANNEL DISH TIME STEP RUN ................................................................. 108
TABLE VI – 168600 CELL NARROW CHANNEL DISH TIME STEP RUN ................................................................. 108
TABLE VII – 172300 CELL NARROW CHANNEL DISH TIME STEP RUN ................................................................. 109
TABLE VIII – 245500 CELL NARROW CHANNEL DISH TIME STEP RUN .......................................................... 109
TABLE IX – DIMENSIONLESS PARAMETER VARIABLES ................................................................................. 110
TABLE X – AVERAGE DIMENSIONLESS SHEAR STRESS EXPERIENCED IN EACH RADIAL LOCATION .. 110
# LIST OF FIGURES

FIGURE 1 – NARROW-CHANNEL FLAT BOTTOM DISH .......................................................... 22
FIGURE 2 – NARROW-CHANNEL BANKED BOTTOM DISH .............................................. 23
FIGURE 3 – CONVENTIONAL DISH .................................................................................. 23
FIGURE 4 – AVERAGE SHEAR VS NUMBER OF CELLS .................................................. 27
FIGURE 5 – SHEAR STRESS VS TIME FOR 168600 CELLS (30) .................................. 28
FIGURE 6 – SHEAR STRESS VS TIME FOR 73712 CELLS (31) .................................. 28
FIGURE 7 – SHEAR STRESS VS TIME FOR 173200 CELLS (32) ................................. 29
FIGURE 8 – SHEAR STRESS VS TIME FOR 245500 CELLS (33) ................................. 29
FIGURE 9 – SELECT FILE WINDOW ................................................................................. 30
FIGURE 10 – SCALE MESH WINDOW ............................................................................. 31
FIGURE 11 – MULTIPHASE MODEL WINDOW .................................................................. 31
FIGURE 12 – CREATE/EDIT MATERIALS WINDOW ........................................................... 32
FIGURE 13 – SECONDARY PHASE WINDOW .................................................................... 32
FIGURE 14 – GRAVITY WINDOW .................................................................................... 33
FIGURE 15 – COMPILED UDFs WINDOW ......................................................................... 33
FIGURE 16 – DYNAMICS MESH ZONES WINDOW ........................................................... 34
FIGURE 17 – SOLUTION METHODS ............................................................................... 35
FIGURE 18 – UNDER-RELAXATION FACTORS WINDOW .................................................. 35
FIGURE 19 – RESIDUAL MONITORS WINDOW ................................................................ 36
FIGURE 20 – INITIAL VALUES WINDOW ......................................................................... 36
FIGURE 21 – REGION ADAPTATION WINDOW ................................................................ 37
FIGURE 22 – CONTOURS WINDOWS ................................................................................. 38
FIGURE 23 – EXPORT DATA WINDOW ............................................................................ 38
FIGURE 24 – COMPARISON OF SHEAR CONTOURS FOR NCF DISH (LEFT), AND NCB DISH (MIDDLE), AND CONVENTIONAL DISH (RIGHT) ................................. 39
FIGURE 25 – NARROW CHANNEL FLAT DISH DIMENSIONLESS SHEAR STRESS CONTOUR 60 RPM
   (STOKES: 0.06, SLOPE: 0.12, FROUDE: 0.18, AND REYNOLDS: 0.01) ......................... 43
FIGURE 26 – NARROW CHANNEL FLAT DISH DIMENSIONLESS SHEAR STRESS CONTOUR 90 RPM
   (STOKES: 0.22, SLOPE: 0.28, FROUDE: 0.27, AND REYNOLDS: 0.15) ......................... 43
FIGURE 27 – NARROW CHANNEL FLAT DISH DIMENSIONLESS SHEAR STRESS CONTOUR 120 RPM
   (STOKES: 0.56, SLOPE: 0.5, FROUDE: 0.36, AND REYNOLDS: 1.01) ......................... 44
FIGURE 28 – NARROW CHANNEL FLAT DISH DIMENSIONLESS SHEAR STRESS CONTOUR 150 RPM
   (STOKES: 0.76, SLOPE: 0.78, FROUDE: 0.45, AND REYNOLDS: 1.89) ......................... 44
FIGURE 29 – NARROW CHANNEL FLAT DISH SHEAR STRESS DIMENSIONLESS CONTOUR 180 RPM
   (STOKES: 0.96, SLOPE: 1.12, FROUDE: 0.54, AND REYNOLDS: 3.03) ......................... 45
FIGURE 30 – NARROW CHANNEL FLAT DISH AVERAGE DIMENSIONLESS SHEAR STRESS VS RPM ................................................................. 45
FIGURE 31 – NARROW CHANNEL FLAT DISH 150 RPM GRAPH AT 10%, 20, AND 40% .................................................. 46
FIGURE 32 – NARROW CHANNEL FLAT DISH 150 RPM GRAPH AT 60%, 80%, AND 90% .................................................. 47
FIGURE 33 - NARROW CHANNEL FLAT DISH 150 RPM AT 40%, 80%, AND 90% .................................................. 48
FIGURE 34 - NCF DISH SLOPE VALUES VS RADIAL LOCATION ........................................ 49
FIGURE 35 – NARROW CHANNEL FLAT DISH DOSI VS LOCATION GRAPH ......................... 50
FIGURE 65 – EXAMPLE INPUT FILE .................................................. 80
FIGURE 66 – NARROW CHANNEL FLAT DISH 60 RPM 10% TO 40% ........................................ 82
FIGURE 67 – NARROW CHANNEL FLAT DISH 60 RPM 60% TO 90% ........................................ 82
FIGURE 68 – NARROW CHANNEL FLAT DISH 90 RPM 10% TO 40% ........................................ 83
FIGURE 69 – NARROW CHANNEL FLAT DISH 90 RPM 60% TO 90% ........................................ 83
FIGURE 70 – NARROW CHANNEL FLAT DISH 120 RPM 10% TO 40% ..................................... 84
FIGURE 71 – NARROW CHANNEL FLAT DISH 120 RPM 60% TO 90% ..................................... 84
FIGURE 72 – NARROW CHANNEL FLAT DISH 150 RPM 10% TO 40% ..................................... 85
FIGURE 73 – NARROW CHANNEL FLAT DISH 150 RPM 60% TO 90% ..................................... 85
FIGURE 74 – NARROW CHANNEL FLAT DISH 180 RPM 10% TO 40% ..................................... 86
FIGURE 75 – NARROW CHANNEL FLAT DISH 180 RPM 60% TO 90% ..................................... 86
FIGURE 76 – NARROW CHANNEL BANKED DISH 60 RPM 10% TO 40% .................................. 87
FIGURE 77 – NARROW CHANNEL BANKED DISH 60 RPM 60% TO 90% .................................. 87
FIGURE 78 – NARROW CHANNEL BANKED DISH 90 RPM 10% TO 40% .................................. 88
FIGURE 79 – NARROW CHANNEL BANKED DISH 90 RPM 60% TO 90% .................................. 88
FIGURE 80 – NARROW CHANNEL BANKED DISH 120 RPM 10% TO 40% ............................. 89
FIGURE 81 – NARROW CHANNEL BANKED DISH 120 RPM 60% TO 90% ................................ 89
FIGURE 82 – NARROW CHANNEL BANKED DISH 150 RPM 10% TO 40% ................................ 90
FIGURE 83 – NARROW CHANNEL BANKED DISH 150 RPM 60% TO 90% ............................. 90
FIGURE 84 – NARROW CHANNEL BANKED DISH 180 RPM 10% TO 40% ............................. 91
FIGURE 85 – NARROW CHANNEL BANKED DISH 180 RPM 60% TO 90% ............................. 91
FIGURE 86 – NARROW CHANNEL CONVENTIONAL DISH 60 RPM 10% TO 40% .................. 92
FIGURE 87 – NARROW CHANNEL CONVENTIONAL DISH 60 RPM 60% TO 90% .................. 92
FIGURE 88 – NARROW CHANNEL CONVENTIONAL DISH 90 RPM 10% TO 40% ................. 93
FIGURE 89 – NARROW CHANNEL CONVENTIONAL DISH 90 RPM 60% TO 90% ................ 93
FIGURE 90 – NARROW CHANNEL CONVENTIONAL DISH 120 RPM 10% TO 40% ............. 94
FIGURE 91 – NARROW CHANNEL CONVENTIONAL DISH 120 RPM 60% TO 90% ............. 94
FIGURE 92 – NARROW CHANNEL CONVENTIONAL DISH 150 RPM 10% TO 40% ............ 95
FIGURE 93 – NARROW CHANNEL CONVENTIONAL DISH 150 RPM 60% TO 90% ............ 95
FIGURE 94 – NARROW CHANNEL CONVENTIONAL DISH 180 RPM 10% TO 40% ............ 96
FIGURE 95 – NARROW CHANNEL CONVENTIONAL DISH 180 RPM 60% TO 90% ............ 96
FIGURE 96 – NARROW CHANNEL FLAT DISH SHEAR STRESS CONTOUR 60 RPM .............. 97
FIGURE 97 – NARROW CHANNEL FLAT DISH SHEAR STRESS CONTOUR 90 RPM .............. 97
FIGURE 98 – NARROW CHANNEL FLAT DISH SHEAR STRESS CONTOUR 120 RPM .......... 98
FIGURE 99 – NARROW CHANNEL FLAT DISH SHEAR STRESS CONTOUR 150 RPM .......... 98
FIGURE 100 – NARROW CHANNEL FLAT DISH SHEAR STRESS CONTOUR 180 RPM ....... 99
FIGURE 101 – NARROW CHANNEL BANKED DISH SHEAR STRESS CONTOUR 60 RPM ....... 99
FIGURE 102 – NARROW CHANNEL BANKED DISH SHEAR STRESS CONTOUR 90 RPM ....... 100
FIGURE 103 – NARROW CHANNEL BANKED DISH SHEAR STRESS CONTOUR 120 RPM ....... 100
FIGURE 104 – NARROW CHANNEL BANKED DISH SHEAR STRESS CONTOUR 150 RPM ....... 101
FIGURE 105 – NARROW CHANNEL BANKED DISH SHEAR STRESS CONTOUR 180 RPM ....... 101
FIGURE 106 – CONVENTIONAL DISH SHEAR STRESS CONTOUR 60 RPM ...................... 102
FIGURE 107 – CONVENTIONAL DISH SHEAR STRESS CONTOUR 90 RPM........................................... 102
FIGURE 108 – CONVENTIONAL DISH SHEAR STRESS CONTOUR 120 RPM.................................... 103
FIGURE 109 – CONVENTIONAL DISH SHEAR STRESS CONTOUR 150 RPM................................. 103
FIGURE 110 – CONVENTIONAL DISH SHEAR STRESS CONTOUR 180 RPM................................. 104
I. INTRODUCTION

Scientists have studied the effects of hemodynamic forces on cellular response for more than 40 years. Many scientists have used Petri dishes on orbital shakers to study cellular responses to fluid forces; however, scientists are still discovering methods to adequately manipulate these fluid forces. The lack of control limits the practicality of using orbital shakers for studying cellular responses. Scholars desire to understand the relationship of wall shear stress (WSS) and cell responses because wall shear stress is regularly accepted as the primary hemodynamic force affecting cellular responses. A new design to the Petri dish that provides control over wall shear stress, in particular, would add validity to simulation attempts thus further benefiting research of hemodynamic forces.

Scientists studying hemodynamic forces utilize Petri dishes on orbital shakers for various reasons. The orbital shakers create an oscillatory flow which provides shear and nutrients to the cells. The oscillating motion of the fluid in a Petri dish is somewhat similar to the pulsatile flow of blood through blood vessels. Lastly, the orbital shakers are preferred because of the ease of use and scalability, where tens or hundreds of experiments can be run simultaneously. When viewed as a whole, the Petri dish and orbital shaker combination has strong advantages to other devices where experiments can generally only be run one at a time.

Studies have shown that endothelial cells, such as those lining the interior walls of arteries and veins, become elongated and aligned with the direction of blood flow, as well as undergo biochemical changes (Levesque & Nerem, 1985). Because of fundamental differences between the actual pulsing flow of blood and the fluid motion in Petri dishes, cellular responses vary in the dish from what is experienced in vivo. Shear stress in these dishes has proven to vary greatly across the surface, making it difficult to correlate to cellular responses.
A new variable called the directional oscillatory shear index (DOSI), developed by Chakraborty (2011), and was defined to help characterize changing direction of flow in Petri dishes. The variable is defined as approaching zero for bidirectional oscillatory shear of equal magnitudes and approaches one for uniaxial oscillatory shear. Conventional dishes exhibited a DOSI approaching zero at the center and a DOSI approaching one at the wall, where large tangential WSS dominated a much smaller radial component. Statistical analysis has shown that DOSI had strong effects on factors such as cell proliferation, morphology, and gene expression. The dependence of these multiple factors on DOSI makes it a good indicator of fluid behavior and an important evaluative tool.

Computational fluid dynamics (CFD) has accurately simulated the flow in orbiting dishes and with more ease than experiments. The key advantage of simulating fluid flow is the ability to determine fluid properties throughout the bottom surface of the Petri dish where cells reside.

The purpose of this thesis was to explore the ability for creating narrow shear ranges in terms of magnitude and direction, and to determine DOSI in novel geometry dishes. The new geometries consist of a narrow channel flat bottom dish and a narrow channel banked bottom dish. The computational work was performed using Fluent, a commercial CFD software package.
II. REVIEW OF RELATED LITERATURE

A. Definition of Shear Stress

Shear stress is a useful fluid property that can be defined as a component of stress acting parallel to a surface, and is proportional to the shear rate. Viscosity is the proportionality variable and was explained by Bird et al. (2002) using a system of two parallel plates, with one moving and one stationary. At steady state, a force $F$ must be applied to the moving plate to maintain a constant velocity. The force is proportional to the plate’s area and velocity, and indirectly proportional to the distance between the two plates. A velocity field is produced within the fluid between the two plates. The velocity gradient is the reciprocal of the slope of the velocity field.

$$\frac{F_s}{A_s} = \mu \frac{u}{y}$$ (1)

Newton as well created a mathematical representation of viscosity and provides additional insight because of it varied form from Bird’s equation. The resulting Newton’s law of viscosity shows shearing force (per unit of area) is inversely proportional to the negative of the velocity gradient:

$$\tau_{xy} = -\mu \frac{du_x}{dy}$$ (2)

In Newton’s equation, $\tau_{xy}$ represents the shear stress, which is the force in the $x$ direction on a unit of area perpendicular in the $y$ direction. The shear stress force exists in all flowing fluids and is essentially how momentum or motion is transferred through a fluid. Newton’s law has been effective at defining the motion for a one-dimensional, laminar flowing, incompressible Newtonian fluid.
B. Experimental Determination of Shear Stress

There are three main methods to generate shear stress in experiments on endothelial cells: parallel plate flow chambers, cone and plate apparatus, and orbital shakers. The parallel plate flow chamber consists of two very long plates and a fluid-filled rectangular gap between the plates, the width of which is much smaller than the length of the two plates. While it is important to compensate for entrance effects when calculating shear stress, the parallel plate chambers produce uniaxial shear with laminar flow between the two plates. When Levesque and Nerem (1985) studied the response of tissue cells exposed to shear stress, they conducted the experiment using the parallel plate method. Levesque and Nerem (1985) developed equation (3) to calculate the shear stress on the endothelial cells.

\[
\tau_\omega = \frac{6\mu^2}{\rho H^2} \cdot Re
\]  

(3)

The cone and plate method also provides a uniform shear field over the entire lower surface on which the apparatus’ fluid resides. The cone and plate apparatus consists of two circular plates that revolve around a central axis. Even though radial speed increases as the distance from the central axis increases, the conical shape of one of the plates creates uniform shear. Ley et al. (1989) used the cone and plate method to understand polymorphonuclear neutrophil granulocyte (PMN) shear-dependent adhesion to endothelial cells. Since shear stress in this system depends on factors such as the rotational speed of the apparatus, basic geometry dimensions, and fluid properties, the derived equation for the behavior of shear stress in the system becomes:

\[
\tau(a) = \frac{2\pi a f \mu}{H}
\]  

(4)
In orbital shakers, the shear stress is generated by the fluid’s wave motion produced by the shaker. Ley et al. (1989) used both an orbiting shaker and cone and plate method to study the shear dependent adhesion of human PMN to endothelial cells. They estimated the shear in the orbital shaker using Stokes’ second problem solution. Unlike Stokes’ first problem that is based on the shear stress of a thick fluid layer fluid moving at a suddenly accelerated to a constant velocity on a very large plate, the second solution is based on the shear stress with a wall moving in an oscillatory motion. The equation was given as:

$$\tau_\omega = a \sqrt{\rho \mu (2\pi f)^3}$$  \hspace{1cm} (5)

The above equation only predicts a scalar value to exist across the dish bottom, and does not seem to adequately compensate for the actual fluid dynamics created by waves with changing fluid heights. Another equation was developed for orbital shakers using the quasi-steady state assumption. This equation is based on viscous favored flow. While the equation is has greater accuracy with lower dimensionless variables (explained in section G), Equation 6 still provides acceptably low error at higher dimensionless values. The calculated shear stress is theoretically applied evenly throughout the dish bottom surface.

$$\tau_\omega = R h \rho \omega^2$$  \hspace{1cm} (6)

C. **Examples of Shear Studies using Orbital Shakers**

There are several examples where orbiting dishes have been used to characterize cellular responses to shear. Research by Ley et al. (1989) investigating PMN led to the results that a shear stress of 1.5 dynes/cm² reduces PMN from 36 % to 21% and 59% to 35% on bovine serum albumin cells. The research also used dextran sulphate to inhibit PMN; however, the dextran sulphate showed no effects as an inhibitor until shear stress was present.
Another research group, Yun et al. (2002) studied the effects of shear stress using shakers on the transcription factor Sp1 phosphorylation on metalloproteinase (MT1-MMP). (Sp1 is a transcription factor activated or inhibited by physiologic and pathologic stimuli. MT1-MMP is an enzyme known to play a major role in cell behaviors, such as cell proliferation, migration, and differentiation, among others.) An orbital shaker was used to create shear stress that then activated or repressed the transcription factor on MT1-MMP. Yun found MT1-MMP responded differently to distinct environmental stimuli, such as cyclic strain versus shear stress.

Kraiss et al. (2003) studied the mechanisms that by shear stress regulate E-selection protein production and activation of p70/p85 S6 kinase in endothelial cells. In the study, they documented that the oscillating motion produced by orbital shakers had a similar reduction in E-selection protein expression as laminar flow produced in a cone and plate apparatus.

Haga et al. (2003) attempted to determine the effects of hemodynamic forces on smooth muscle cells utilizing an orbital shaker. Despite previous findings that shear stress inhibited cell proliferation; they found that the oscillatory shear stress unexpectedly increased proliferation of smooth muscle cells. The contradictory results were hypothesized to be an effect of oscillatory versus steady state flow, but that oscillatory shear remains more physiologically relevant to the pulsatile blood flow. They suggested that additional research aimed at defining variation between oscillatory and steady state shear would be preferential. A proper defined relationship would provide several advantages for example the ability to relate different research findings despite the type of shear stress used.

While attempting to understand orbital shaker flow pattern, Dardik et al. (2005) experimented with the effects of orbital and laminar shear stress on endothelial cells and compared the effects of morphology, proliferation, and apoptosis. The resulting data helped to characterize the different flow
patterns and nature of the orbiting dishes. For example, they observed an absence of shear stress at the middle of the dish as opposed to large shear stress effects at the periphery.

D. Computational Fluid Dynamics

While computational fluid dynamics (CFD) originated in the 1940s with the creation of the first digital computer, computational fluid dynamics usage began to increase only with the advancement of computers and the readily available software in the late 1950’s. Computational fluid dynamics is based on transport phenomena, which concerns the transfer of energy, mass, and momentum. Computational fluid dynamics software programs offer the advantageous ability to instantaneously solve multiple equations that would be inefficient to solve simultaneously otherwise. By simultaneously solving the governing transport equations, programs like Fluent, CFX, or Flow 3D are able to calculate fluid properties and simulate fluid transport.

Navier-Stokes equations are the governing transport phenomena equations Fluent uses to solve for fluid motion. The exact equations used by Fluent when calculating fluid flow are as follows:

For conservation of mass:

\[
\frac{\partial \rho}{\partial t} + \frac{\partial}{\partial x_i} (\rho \ast u_i) = S_m
\]  

(7)

For conservation of momentum:

\[
\frac{\partial}{\partial x_i} (\rho \ast u_i) + \frac{\partial}{\partial x_j} (\rho \ast u_i \ast u_j) = - \frac{\partial p}{\partial x_i} + \frac{\partial \tau_{ij}}{\partial x_j} + \rho \ast g_i + F_i
\]  

(8)

For calculating shear stress:
\[ \tau_{ij} = \left[ \mu \left( \frac{\partial \tau_i}{\partial x_j} + \frac{\partial \tau_j}{\partial x_i} \right) \right] - \frac{2}{3} \mu * \frac{\partial \tau_i}{\partial x_i} * \delta_{ij} \] (9)

For conservation of energy:

\[ \frac{\partial}{\partial t}(\rho * h) + \frac{\partial}{\partial x_i}(\rho * u_i * h) = \frac{\partial p}{\partial x_i} \left( k * \frac{\partial T}{\partial x_i} \right) - \frac{\partial}{\partial x_i} \sum h_j * J_j + \frac{\partial p}{\partial t} + u_i \frac{\partial p}{\partial x_i} + \tau_{ij} \frac{\partial u_i}{\partial x_j} + S_h \]

(10)

The variables are defined as

\[ h = \sum_i m_i * h_i \] (11)

\[ h_i = \int_{T_{ref}}^{T} c_p dT \] (12)

For conservation of chemical species:

\[ \frac{\partial}{\partial t}(\rho * m_i) + \frac{\partial}{\partial x_i}(\rho * u_i * m_i) = \frac{\partial}{\partial x_i} \left( J_{i^1,i^2} \right) + S_i \]

(13)

where the J variable is defined as:

\[ J_{i^1,i^2} = -\rho * D_{i^1,i^2} * m * \frac{\partial m_i}{\partial x_i} \] (14)

The equations above are not solved in their partial differential forms, but are reduced to algebraic equations using the finite difference method. These simpler algebraic equations can be written as:

\[ \varphi_p \sum_i (A_i - S_p) = \sum_i A_i \varphi_i + S_c \] (15)
where the variable $A$ is the coefficient from diffusive and convective fluxes and $S$ variables are defined as:

$$S_\varphi = S_c + S_p \cdot \varphi_p$$  \hspace{1cm} (16)

With the initial input conditions, Fluent iterates the equations in each cell. Cells are small volumes that make up the simulated object. Each cell is treated as a single point with its own fluid properties and values. More cells correlate to a higher resolution, however more cells also correlate to longer computational times for Fluent.

The $u$, $v$, and $w$ momentum equations are solved using pressure to determine the velocity field. If either the velocity field or pressure does not follow the continuity equation, corrections are made. Once the pressure and velocities are correct, all other conservation equations are solved based on those results. The fluid properties are then updated based on the auxiliary equations. Once the difference between successive iteration steps reaches a defined value or a defined number of iteration steps the calculation stops.

The main approach used by CFD to discretize the governing equations is illustrated by a simple one dimensional equation:

$$\frac{du}{dx} + u^m = 0; \ 0 \leq x \leq 1; \ u(0) = 1$$  \hspace{1cm} (17)

The variable $m$ helps define both linear $(m=1)$ equations and nonlinear equations $(m=2)$. When $m=1$ in a linear equation, the equation will result in four equally spaced points with $\Delta x = .33$. In practice, the CFD process variable will be one of the four points, thus, the governing equation in each cell or grid point would be:

$$\left(\frac{du}{dx}\right)_i + u_i = 0$$  \hspace{1cm} (18)
The Taylor series is also used to solve for the \( u \) variable. In the end, all the differential equations are converted into distinct linear equations instead of using continuous variables.

The two finite difference methods most commonly used are finite volume method and finite element method. Fluent uses the finite volume method. In the Fluent program, the geometries are divided into triangles for 2D meshes and tetrahedral, hexahedral, or prism for 3D meshes. When applying the governing equation to each cell volume, the discrete equations used to solve the process are created. The continuity equation for steady state incompressible flow is:

\[
\int_S \vec{V} \cdot \vec{n} ds = 0
\]  

(19)

The \( S \) is the surface of the volume and \( n \) specifies a normal direction. Similar equations are used for discretization of conservation of momentum and energy equations.

The finite element method is another technique used to discretize. The finite element method identifies boundary conditions for inter-connected regions or elements. Once the boundary conditions have been generated using discretization, the governing equation can be solved for all elements. While this method was originally used to study stress in airframe structures, it has grown in popularity with fluid flow systems. Ansys, Adina Feam, and ABAQUS are among the more popular finite element software providers.

**E. Types of Shear Stress**

1. **Uniaxial Shear**

   The effects of different types of shear stress on endothelial cells have been analyzed. Examples include uniaxial shear, uniaxial oscillatory shear, and uniaxial pulsatile shear. Steady uniaxial shear has been proven to change cell length and orientation by Yamaguchi et al. (1993). In their study, a three dimensional CFD case was designed to model the endothelial cell with simulated
shear. As the flow was simulated, the change in cell shape was monitored. The results showed that the cells became elongated in the direction of flow. Levesque et al. (1985) directly studied the cell effects to define how much elongation and change in orientation of endothelial cells happened in response to shear stress. However, unlike Yamaguchi et al, Levesque et al grew cells in the study and documented how the cells responded. The response was that the cells became more elongated with larger shear stress. Inoguchi et al. (2007) documented that by gradually increasing shear stress, endothelial cell detachment decreased with an increase in cell elongation and cell alignment in the direction of flow. Endothelial cell stiffness induced by shear stress was investigated by Sato et al. (2000). As measured by atomic force microscopy, shear stress created cell elongation and nucleus movement to the downstream side. At the six hour exposure mark partial stiffness was noted with total stiffness achieved at 24 hours of shear stress. Zhao et al. (2007) showed that uniaxial wall shear stress can cause endothelial cells to align with and elongate in the direction of flow. It was found that together shear stress and hoop stretch created different morphologic response than either alone.

Chotard-Ghodsnia et al. (2007) studied tumor cell morphology as the tumors interacted with endothelial cells primarily under uniaxial flow. The shear stress not only affected morphology but also the mechanical properties of endothelial cells. For example, the attachment of tumor cells on endothelial cells was proven to be shear-dependent. However, once attached, shear stress had no effect on the radial spreading of tumor cells, but did affect axial spreading of tumor cells. The radial spreading of the tumor cells equated to migration through the vascular endothelial cells while axially meant forming a mosaic tumor endothelial monolayer. In the Fukushima et al. (2001) study, endothelial cells were measured by the geometry change of cells as they experienced shear stress. The study used a confocal laser scanning microscopy to determine the shear stress distribution and surface geometry change by particle tracking velocimetry. The study included both cells that had experienced fluid flow and static fluid. The study showed that the shear stress
distribution closely correlated to the surface geometry on a cell and those cells in proximity. Li et al. (2005) also investigated the relationship between shear stress generated by channel flow and cellular responses. The study noted that endothelial cells hold the capacity to sense the mechanical stimulus of laminar, disturbed, or oscillatory shear stress flows and in turn signal a reaction to other cells. They concluded that shear stress must aid in regulation of endothelial cell functions that communicate by intercellular signaling networks.

In a previous study Mailovanova et al. (2004) showed the effects shear stress induced by slowing or stopping flow on endothelial cells. A simulated ischemia caused a depolarization of cell membranes and an increase production of reactive oxygen species, ultimately showing an increase in cellular proliferation efforts of transcription factor activation and faster DNA synthesis. As a follow up, another study was used to evaluate cellular proliferation and to determine the role of activating reactive oxygen species. Milovanova et al. (2006) postulated that the production of reactive oxygen species (ROS) are a signal of endothelial cell proliferation associated with shear stress loss. In the end, the study proved that the loss of shear stress in the flow CD31-positive pulmonary microvascular endothelial cells resulted in cell division associated with ROS generation.

Kudo et al. (2003) investigated the long term affects that uniaxial shear stress had on calcium response and morphology of endothelial cells. With time periods ranging from 15 minutes to 24 hours the study found that while there was an immediate calcium response to initial flow, the calcium response subsided with long term shear stress exposure. When Secomb and Pries (2001) studied the transmission of uniaxial shear stress to endothelial cells in blood vessels lined with an endothelial surface layer, two significant findings emerged. First, the transmission of shear stress happens mostly at the attachment points of the endothelial surface layer to the cell membrane. Second, the presence of an endothelial surface layer altered the spatial phenomenon of how the cells responded to shear stress, decreasing the effects of rapid shear stress fluctuations on endothelial cells. Slater et al.
(2002) studied the effect of hypothermic temperatures on endothelial cells as a way of judging the validity of perfusion preservation on a hypothermic liver. Increased cell rounding was observed during increases in shear during hypothermic machine perfusion preservation. In addition, the study determined that cellular rounding in hypothermic conditions can be discouraged by low machine flow rates. Nagayama et al. (1995) studied the morphology and migration of endothelial cells. The results suggested that the initial orientation and shape of the cells affected how external shear stress was responded to. This response was theorized as an organizational effect due to the interaction of neighboring cells. Similarly, Tanishita et al. (1999) studied the morphology and migration of individual cultured cell with wall shear stress of 3 and 5 Pascals. Using a microscope they were able to observe that the original orientation and shape of the cells affected the receiving of external shear stress. Because cell shape depends on surrounding cells the external shear stress stimulus resulted in a small grouping behavior.

Fernandez et al. (2006) studied the effects of uniaxial shear stress on endothelial cells when seeded on vascular grafts. The results proved that seeded endothelial cells do transduce shear stress in closed clinical conditions. Their positive results provided new insights into vascular tissue engineering. Some scientists believe that seeding autologous endothelial cells onto the lumen of the vessel prior to implantation will improve long-term patency of vascular prosthesis. This involves pre-treating the prosthesis material with fibrin, collagen, or other matrix molecules to encourage cell attachment and retention. It was documented by Feugier et al. (2005) that the ability to adhere to the cells depended on the coating. In some cases fewer than 30% of the cells remain after only one hour exposure to physiological levels of shear stress. Vascular endothelial cells are consistently subjected to shear stress and neighboring smooth muscle cells. Chiu et al. (2004) developed a study to document the effects of shear stress on endothelial cells (ECs) and neighboring smooth muscle cell (SMC) interactions. When co-cultured SMCs were exposed to a shear stress magnitude of 12
dynes/cm², the cells tended to orient perpendicular to flow. This orientation was not observed when exposed to 2 dynes/cm². This observation along with others suggested that shear stress serves as a down-regulator for the pathophysiologic gene expression of ECs co-cultured with SMCs. Cellular permeability affected by shear stress has been an important topic for researchers. The shear stress by acting on the endothelial cell walls affects cellular permeability. Sakamoto et al. (2004) studied the effects of shear stress on permeability of the endothelial monolayer using a co-culture model of endothelial cells and smooth muscle cells. Similar to Chiu et al. (2004) the results suggested that cellular interaction between ECs and SMCs were effected by permeability thus shear stress. Drug delivery systems require the ability to predict the environment-specific responses of target cells. In a study done by Hughes et al. (2005) it was observed that endothelial cell migration into a scrape wound was enhanced in sphingosine 1-phosphate by shear stress. In the same study vascular endothelial growth factor stimulated human umbilical vein endothelial cells to migrate into a scrape wound by the addition of shear stress. Tang et al. (2002) was able to utilize 3-D computational modeling in combination with experimental data to better understand shear stress distribution on endothelial cell membranes.

2. Uniaxial Oscillatory Shear

The effect of uniaxial oscillatory shear had varying effects on human cells. Chappell et al. (1998) investigated uniaxial oscillatory shear on adhesion molecule expressions for endothelial cells. The study showed that the shear stimulated adhesion of mononuclear leukocyte cells and increased migration into the arterial wall. Ku et al. (1985) discovered the impact of shear reversals on atherosclerotic plaque formation in human carotid bifurcation. In order to understand the effects of oscillatory shear index, the OSI variable was developed in order to help measure the reversal of shear in the study:
\[
OSI = 1 - \frac{\left| \int_0^T \tau_w \, dt \right|}{\int_0^T |\tau_w| \, dt}
\]  

(OSI is zero for steady one directional flow but unity for fully reversing or oscillatory flow. Specifically in the Ku et al. experiments, shear stress at five axial and four circumferential positions were correlated to intimal plaque thickness. They found a strong correlation between OSI and intimal thickness. As a follow up to Ku et al. (1985) study Ding et al. (2001) sought to vary the correlation and determine whether the correlation could be improved by a tuning fork shaped model that more closely modeled an average human carotid bifurcation. The conclusion of the study was that the TF-shaped model was closer to human carotid bifurcation. Additionally there was a strong positive correlation between OSI and intimal thickness. The TF-shaped model was an improvement over the traditional Y-shaped model.

3. **Uniaxial Pulsatile Shear**

Pulsating shear has also been shown to affect cellular responses. Owatverot et al. (2005) found that the pulsating flow has a strong effect on cell orientation. Their study showed that both magnitude and direction of the cycling flow individually produced a cell response. In another study, Hsiai et al. (2002) discovered that pulsating shear did a better job at elongating and realigning cells than non-pulsing shear. Laminar flow is the predominant flow regime in biological systems but can appear as turbulent in special cases. Because of this fact there have been investigations comparing the effects of laminar and turbulent shear stress. In a study by Davies et al. (1986) the comparison of laminar and turbulent pulsatile flow on vascular endothelial cells resulted in the understanding that the unsteady blood flow characteristic, not the magnitude of wall shear stress, was the major contributor of shear-induced endothelial turnover. This conclusion was achieved by exposing
endothelial cells to laminar shear stress ranging from 8 – 15 dynes/cm\(^2\) for 24 hours and turbulent shear stress as low as 1.5 dynes/cm\(^2\) for 3 hours.

He and Ku (1996) focused on understanding localization of atherosclerosis thought to be governed by local hemodynamic forces. The pulsatile hemodynamics of the left coronary artery bifurcations was numerically simulated using the spectral element method. It was observed that velocity skewing arose from bifurcation and curvature of the artery. As was expected the arterial wall shear stress was significantly lower in the bifurcation region, with the largest oscillatory behavior concentrating on the outer wall of the artery. Frangos et al. (1988) used a flow apparatus to subject endothelial cells to steady and pulsatile shear stress. The study demonstrated that the shear stress in certain ranges may not harm mammalian cell metabolism. Furthermore, according to the research metabolite production is maximized by maximizing shear stress. Chien et al. (2001) presented a study analyzing endothelial cells in a dynamic state and response to alternations in shear stress by signal events that influence their performance. Himburg et al. (2007) showed that inflammatory response of endothelial cells evoked by higher frequency of shear stress became more pronounced by reversing and oscillatory shear. This lead to the conclusion that an arterial region subjected to both shear reversal and dominant frequencies of shear stress that exceed the normal heart rate are at greater risk to health issues like atherosclerotic lesion development. Hwang et al. (2003) further studied the effects of pulsatile and oscillatory shear stress on NADPH oxidase expression. They subjected bovine aortic endothelial cells to various magnitudes of shear stress that were pulsatile and oscillatory in nature. In the end the study showed that the oscillatory shear stress creates greater oxidative stress by O2 production, thus enhances LDL oxidation and upped regulation of inflammatory markers. Prior to Barabac et al. (2006), it was understood that bone mass and structure changed in response to changes in mechanical loading, however, it was not understood how
the cells sense the vibration stress. Barabec et al. showed a path or correlation between nitric oxide and prostaglandin E2 would provide a way for the cellular mechano-sensing of loading.

F. DOSI

Chakraborty (2012) created DOSI (directional oscillatory shear stress) to compensate for the bidirectional motion of oscillating dishes. DOSI was defined as:

\[
DOSI = 1 - \frac{OSI_2}{OSI_1}
\]

\[
OSI_1 = 1 - \frac{|\int_{0}^{T} \tau_1 dt|}{\int_{0}^{T} |\tau_w| dt}
\]

\[
OSI_2 = 1 - \frac{|\int_{0}^{T} \tau_2 dt|}{\int_{0}^{T} |\tau_w| dt}
\]

\[
\int_{0}^{T} \tau_1 \tau_2 dt = 0
\]

The numerical subscripts specify the vector direction of primary and secondary directions. The Taus \((\tau_1, \tau_2)\) represent shear stress in a particular direction with \(\tau_1\) being greater in magnitude. The \(\tau_w\) represents the combined or resultant shear stress. DOSI is zero when oscillations in both directions are equal in magnitude and unity for uniaxial shear whether there is a reversal or not. As \(OSI_1\) and \(OSI_2\) approach zero the larger of the two will always occupy the denominator. Chakraborty (2011) investigated the effects of oscillatory wall shear stress on endothelial cellular responses like cell proliferation, morphology, and atherogenic gene expression. The comprehensive statistical analysis showed that DOSI was the strongest determinant of proliferation, area, shape index, and angle of cell orientation.
G. Dimensionless Parameters

The scientist Osborne Reynolds in 1883 succeeded in demonstrating the difference between low pressure drops at low flow rates and disproportionally high pressure drops at high flow rates. Reynolds set up a control by flowing water through a glass tank. By adding a stream of colored water, Reynolds made it possible to see how the water flowed through the tank. Reynolds found that at low Reynolds numbers the stream of colored water stayed together through the pipe, however at high Reynolds numbers flow rates the dye would diffuse through the clear water flow.

The motion type at low flow rates is called laminar flow. Laminar flow describes fluids without lateral mixing in which the layers slide past each other. The second type of flow regime called turbulent flow, has high flow rates and is characterized by cross-currents and eddies. Eddies are swirls in the fluid that allow for a greater amount of energy transfer. Because of the chaotic nature of the eddies, mixing increases in all directions.

Because of this research, a dimensionless variable named Reynolds number was developed. Although the Reynolds equation changes for different flow geometries, the Reynolds equation for flow in a pipe is:

\[ Re = \frac{v*D}{\nu} \]  \hspace{1cm} (24)

The Reynolds number is classified as a ratio of inertial forces to the viscous forces. Under the conditions of a flat plate flow, turbulent flow starts at around $10^5$ and becomes fully developed by $3 \times 10^6$. Since Reynolds number was defined, several empirical equations have adopted the variable into equations to solve for other variables. For example, for pipe flow applications the amount of friction, which affects phenomena such as pressure drop of a fluid, are determined as functions of Reynolds number.
As the properties surrounding interactions with a flowing fluid change the Reynolds number takes different forms. For example, in mixing tanks the Reynolds equation changes to:

\[
Re = \frac{N \cdot D^2 \cdot \rho}{\mu}
\]  

(25)

In the equation N is the impeller speed, in rev/s, and d is the impeller diameter. Based on this equation the transition from laminar to turbulent occurs between a Reynolds numbers of 50 to 5000.

For the Petri dish, the characteristic velocity is the orbital speed (\(\omega\)) and the characteristic dimension of the fluid is height (\(H\)), so the Reynolds number is:

\[
Re = \frac{H \cdot a \cdot \omega \cdot \rho}{\nu}
\]  

(26)

The mathematician George Gabriel Stokes developed the Stokes Number among other famous equations such as the Navies-Stokes equations. It was in 1845 that he began studying friction on fluids in motion. Stokes developed a law that defined the frictional force exerted on spherical objects in a viscous fluid. In orbital dishes, it is defined as the ratio of inertial forces from the dishes versus the viscous forces from the fluid:

\[
St = H \cdot \sqrt{\frac{\omega}{\nu}}
\]  

(28)

For low Stokes Number, the fluid motion will be viscous dominated, for high Stokes Number the flow will be unsteady.

The Froude number was developed by the English engineer, William Froude. He studied the stability of ships in a seaway in 1861. The Froude number he developed arose from his quantification of resistance of floating objects. More specifically the Froude Number compares inertial and gravitational forces and is defined as a ratio of speed/length:
\[ Fr = \frac{u}{\sqrt{g \cdot H}} \]  

(29)

For low Froude Numbers, the leading edge has the same slope as the rest of the leading edge of the wave. At a value of one the fluid reaches standing wave. For high Froude Numbers (or when Froude is greater than one), the front wave becomes unsteady and crashes similar to the shape and motion of waves on a beach. Because determining the actual speed of the fluid is difficult in the dish, past experiments have define this term by multiplying revolution speed ($\omega$) and characteristic width ($a$). (Fluid velocity would be a function of both of these terms.)

The slope ratio is used to measure the steepness of the free surface of the fluid in the dish. For these cases the slope ratio is defined as the ratio of the quasi-steady free surface slope and the aspect ratio of the fluid at rest:

\[ Sl = \frac{R \cdot a \cdot \omega^2}{g \cdot H} \]  

(30)

A new dimensionless variable surrounding wall shear stress was utilized. This new variable will be referred to as dimensionless shear (DS). Dimensionless shear is the ratio of wall shear stress calculated by Fluent (Equation 8) to shear stress calculated by Equation 6:

\[ \tau_{DH} = \frac{\tau_{ij}}{\tau_{wss}} \]  

(30)

All of the dimensionless variables depend on the fluid height. While convention and past experiments dictate what the fluid height is in the conventional dish, the new geometries require a different approach. When studying open channel flow, a concept that is similar to the fluid path in the narrow channel dishes, the fluid height is defined as the hydraulic depth. This is a ratio of the area of
the channel’s cross section to the wetted wall perimeter of the channel. This same definition will be utilized to define fluid height in the narrow channel dishes and is displayed below:

\[ D_H = \frac{A}{WP} \]  

(30)
III. RESEARCH METHODS

A. Simulation Plan

The three geometries consist of a narrow-channel flat bottom dish (NCF), narrow-channel banked bottom (NCB) dish, and conventional cylinder Petri dish. Dimensions of the tested geometries are displayed in the following three figures.

FIGURE 1 – Narrow-Channel Flat Bottom Dish
As this study is a follow up on previous studies such as Chakraborty (2011), Thomas (2007), and Berson et al. (2008) it was necessary to mimic various design specifications in those studies. The pertinent variables from those studies that were used here are: rotational speeds of 60RPM, 90RPM, 120 RPM, 150 RPM, 180 RPM; outer dish radii of 35 mm; water height of 2 mm; orbital radius of 9.5mm, and liquid density and viscosity of water.
Past simulation work plans were designed based on dimensionless parameter values. However, manipulation of the independent variables (kinematic viscosity, orbital speed, etc.) for the dimensionless variables sometimes creates physically unrealistic values. To study only physically relevant values, the dimensionless variables were not used as a basis for work plan, limiting some comparisons. Values are generally within the ranges used previously. For example, Thomas (2007) ran cases for a range of Stokes number of 1 – 10, Froude number of .1 to 1.2, and a slope ratio of .1 to 10. The calculated dimensionless variables are in Table I below.

The slope ratio number required modification for the NCB cases, to account for the angle of the bottom of the banked bottom dish. In theory because of the banked bottom being a 45 degree angle, the slope ratio should approach unity at resting and decreases as orbital speed increases. The new equation satisfies this phenomenon:

\[ Sl_{mod} = 1 - \frac{R \cdot \omega^2}{\tan \theta \cdot g} \]  

(31)
**TABLE I – Dimensionless Variables**

<table>
<thead>
<tr>
<th></th>
<th>Orbital Speed</th>
<th>Stokes</th>
<th>Slope</th>
<th>Froude</th>
<th>Reynolds</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Narrow Channel</strong></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Flat</td>
<td>60</td>
<td>0.06</td>
<td>0.12</td>
<td>0.18</td>
<td>0.01</td>
</tr>
<tr>
<td></td>
<td>90</td>
<td>0.22</td>
<td>0.28</td>
<td>0.27</td>
<td>0.15</td>
</tr>
<tr>
<td></td>
<td>120</td>
<td>0.56</td>
<td>0.50</td>
<td>0.36</td>
<td>1.01</td>
</tr>
<tr>
<td></td>
<td>150</td>
<td>0.76</td>
<td>0.78</td>
<td>0.45</td>
<td>1.89</td>
</tr>
<tr>
<td></td>
<td>180</td>
<td>0.96</td>
<td>1.12</td>
<td>0.54</td>
<td>3.03</td>
</tr>
<tr>
<td></td>
<td>60</td>
<td>0.03</td>
<td>0.96</td>
<td>0.13</td>
<td>0.003</td>
</tr>
<tr>
<td></td>
<td>90</td>
<td>0.12</td>
<td>0.91</td>
<td>0.19</td>
<td>0.04</td>
</tr>
<tr>
<td></td>
<td>120</td>
<td>0.30</td>
<td>0.85</td>
<td>0.26</td>
<td>0.29</td>
</tr>
<tr>
<td></td>
<td>150</td>
<td>0.41</td>
<td>0.76</td>
<td>0.32</td>
<td>0.53</td>
</tr>
<tr>
<td></td>
<td>180</td>
<td>0.52</td>
<td>0.66</td>
<td>0.39</td>
<td>0.86</td>
</tr>
<tr>
<td><strong>Narrow Channel</strong></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Banked</td>
<td>60</td>
<td>0.14</td>
<td>0.33</td>
<td>0.78</td>
<td>0.18</td>
</tr>
<tr>
<td></td>
<td>90</td>
<td>0.56</td>
<td>0.75</td>
<td>1.18</td>
<td>2.75</td>
</tr>
<tr>
<td></td>
<td>120</td>
<td>1.45</td>
<td>1.34</td>
<td>1.57</td>
<td>18.36</td>
</tr>
<tr>
<td></td>
<td>150</td>
<td>1.98</td>
<td>2.09</td>
<td>1.96</td>
<td>34.42</td>
</tr>
<tr>
<td></td>
<td>180</td>
<td>2.51</td>
<td>3.01</td>
<td>2.35</td>
<td>55.07</td>
</tr>
</tbody>
</table>

**B. Software**

Fluent was the CFD software used for the simulations. The Speed School of Engineering’s Adelie Computer network, a 64 Linux cluster parallel system based on the AMD Opteron processor was used to run Fluent. The operating system was SUSE LINUX 9.1 Professional Edition. The two
main Adelie advantages are the ability to run multiple cases and processing speed. The system consists of 6 nodes with a total 12 processors yielding 43 Gigaflops of combined processor speed.

A user defined function (UDF) was developed to generate the motion of a shaker plate. The counter clockwise orbit of the dish was specified in terms of orbital frequency, center of orbit, and orbital radius. The UDF is read into Fluent as a part of the moving dynamic mesh capability. The UDF was especially useful due to the unsteady state flow and need for the dynamic mesh to move through space. The UDF code can be found in APPENDIX A.

The free motion of the fluid requires tracking of the liquid-air interface which was accomplished with the Volume of Fluid model. In this model the two fluids (water and air) share a single set of momentum equations and the volume fraction of each fluid in each computation cell is tracked.

C. Create Dish in Fluent

The profile of the geometries were created and then rotated around a central axis using Fluent’s extraction feature. Once the cylinders were created, a computational mesh was applied. Berson et al (2008) determined the optimum mesh count at 300,000 hex shaped cells. Thus the standard dish was also set at that cell count here. The cell count for the narrow-channel dishes were first set to a proportional number based on volume. In order to determine the best dimensions of the mesh several cases were run in order to get an approximation of time and mesh size needed to approach steady state. Meshes of differing height and thickness and number of revolutions were examined. The cases were run until increases in cell number showed no variation in predicted shear stress average, shear stress maximums, and shear contour appearance. Table III through VIII in APPENDIX B and Figures 4 through 8 represent the totality of cases run to verify the best mesh size and run time. After running cases 1 – 29, four were selected (30-33) based on ending average shear stress and maximum shear stress values. The ending values were chosen based on the high cell mesh cases 15 – 21. The
values shown in the tables were 0.88 dynes/cm² for average shear and 2.1 dynes/cm² for maximum shear. Each of the four cases chosen for further analysis had the required shear stress values but had a decreased number of cells because small meshes result in smaller computational time. The results were: case 30 had 168600 cells, average shear of .88 dynes/cm², and maximum shear of 2.15 dynes/cm², case 31 had 73712 cells, average shear of .83 dynes/cm², and maximum shear of 2.05 dynes/cm², case 32 had 172346 cells, average shear of .89 dynes/cm², and maximum shear of 2.12 dynes/cm², case 33 had 245500 cells, average shear of .89 dynes/cm², and maximum shear of 2.12 dynes/cm². The four cases were then run while saving time steps. The results show, that no matter which mesh, after one revolution shear stress values for average and maximum had stabilized. In the end for the narrow channel dishes around 170,000 cells per mesh were selected and 2 complete revolutions. The results are shown in Figures 4-8 below.

FIGURE 4 – Average Shear Vs Number of Cells
FIGURE 5 – Shear Stress vs Time for 168600 Cells (30)

FIGURE 6 – Shear Stress vs Time for 73712 Cells (31)
FIGURE 7 – Shear Stress vs Time for 173200 Cells (32)

FIGURE 8 – Shear Stress vs Time For 245500 Cells (33)
D. Set-Up Fluent Case

1. **Import the mesh**

Open the 3D version > File > Read > Case (a Select File window will open.) > Select the appropriate .msh file.

![Select File Window](image)

**FIGURE 9** –Select File Window

2. **Correct Units**

Fluent will assume that your mesh dimensions are consistent with Fluent’s default settings. If the default is the same as the original size the unit will not need to be corrected. Otherwise, click Grid > Scale > Scale Grid window (click down arrow, select “cm”, then click on Change Length Units > Scale > Close.)
3. **Modeling Technique**

The user must provide Fluent with information about the initial phases and modeling technique for each particular case. During this experiment there were two phases water and air. Click Define > Models > multiphase > Model > Volume of Fluid > OK.
4. **Specify Fluid Properties**

The create/edit material interface allows the user to manipulate the properties of the fluids in the case. This allows for the creation of new materials with set properties or a selection of materials from a database.

![Create/Edit Materials Window](image1)

**FIGURE 12 – Create/Edit Materials Window**

Click Define > Material > Fluent Database > Scroll down under Fluent Fluid Materials > Select water-liquid > Copy > Close

5. **Assign materials to phases**

The user can name each phase material for easy reference. Click Define > Phases > set primary phase to air and secondary to water

![Secondary Phase Window](image2)

**FIGURE 13 – Secondary Phase Window**
6. **Gravity**

The direction and magnitude of gravity is important and must be set properly to insure realistic results. Click Gravity > Gravitational Acceleration > -9.81 m/s\(^2\) for z component > OK

![Gravity Window](image)

**FIGURE 14 – Gravity Window**

7. **Add Motion to Library and mesh**

The orbiting motion of the dishes specific to shaker plates has to be created. The coding for the UDF can be found in APPENDIX A. Once Fluent has been updated with the motion it must then be assigned to the mesh.

![Compiled UDFs Window](image)

**FIGURE 15 – Compiled UDFs Window**

Click Define > User-Defined > Functions > Compiled > Sources Files > Add > Select UDF file > OK
Define > Dynamic Mesh > Create/Edit > Specific a Zone > Specific a Dynamic Mesh Zone > Select Motion UDF/Profile > Create > close

8. Solution Methods

The Navier-Stokes equations provide Fluent with set method to calculate the fluid dynamics of the cases further specification of the exact methods can be entered through solution controls.
Solution Methods: Change Pressure-Velocity Coupling Scheme to PISO; Gradient to Green-Gauss Cell Based; Pressure to Body Force Weighted; Momentum to Quick; Volume Fraction to Geo-Reconstruct

Solution Controls > Change all Under-Relaxation Factors to 0.3

Monitors > Select Residuals – Print > Create > Change Absolute Criteria to .0001
9. Patch in the Water Phase

The fluids present in the model must be patched to the appropriate region. Patching consists of specifying a region for a specified material to occupy.

Click Solve > Initialize > Click initialize

Select Adapt > Region > Input Coordinates > Input X Y and Z, Min and Max > Mark > Solve > Initialize > Patch > water value 1 > Registers hexahedron-r0 > Patch
10. Completing Fluent Set-Up

Calculation Activities > Set Autosave (E.g. 205) > Run Calculation > Set Time Step Size to .001

File > Write > Case and Data File

11. Set-up Batch Run

A batch run consists of running the case in the background of the Adelie system. Two files are needed to run a Fluent case this way, a batch file and an input file. The batch file opens Fluent to initiate the run. The sixth line of the batch file indicates the file locations where the input file is read. The seventh line specifies the file location where the output file is written. Once initiated, the input file dictates more Fluent operating conditions. For example, line one loads the initial case file, line two loads the initial data file, line five sets the number of time steps, line six sets the number of iterations per time step, line seven records the final case file, and line seven records the final data file. An example batch and input file are located in APPENDIX A.
E. Analyzing Data

To display shear contours: Graphics and Animations > Contours > Contours of Wall Fluxes

![Contours Window](image)

To export data to use for DOSI calculations in a spreadsheet:

File > Export > Solution Data > File Type - ASCII > Surfaces – (select appropriate surface) > Quantities – (specify all quantities needed)

FIGURE 22 – Contours Windows

![Export Data Window](image)

FIGURE 23 – Export Data Window
IV. RESULTS AND DISCUSSION OF RESULTS

A. General Discussion

The geometries were evaluated by shear stress contours, tangential vs radial plots, trend line slopes, and DOSI values. The shear stress contours consist of the shear stress at the bottom surface, of each geometry. The shear contours are beneficial because they provide a simple way to visually inspect shear magnitudes and patterns. Figure 24 shows shear stress contours for each dish. Surprisingly, the shear stress values were similar in magnitudes among the dish. In the figure, the contours are shown for an orbital speed of 180 RPM. The ranges for the conventional dish data (right) were from 0 – 22 dynes/cm², for NCF dish (left) were from 0 – 20 dynes/cm², and for the NCB dish (middle) were from 0 – 26 dynes/cm². In the following sections the shear contours will be displayed with dimensionless shear but contours displayed with normal shear stress are available in APPENDIX B Figures 96 - 110. In conjunction with the dimensionless shear contours are the dimensionless shear vs RPM plots. These plots display the average dimensionless shear a cell would experience at each radial location (Figures 30, 42, and 55). These plots are beneficial because they easily show the variation in shear between the different radial locations.

![Figure 24 – Comparison of Shear Contours](image)

FIGURE 24 – Comparison of Shear Contours for NCF dish (left), and NCB dish (middle), and Conventional dish (right)
The complete set of tangential vs radial plots can be found in APPENDIX B: NCF dishes in Figures 66 - 75, NCB dishes in Figures 76 - 85, and conventional dishes in Figure 86 - 95. A few select cases appear in the following sections for discussion (Figures 31 – 32, 43 – 44, and 56 – 59). The tangential vs shear plots visually show the direction of shear on the bottom dish surfaces. In the plots a circular or elliptical plot represents oscillatory flow while a stretch towards either axis represents a shift towards more uniaxial flow. For example, Figures 31- 32 and 43 - 44 show the elongation towards tangential flow that occurs in both NCF and NCB dishes. The conventional dish cases, Figure 56 - 59, show a circular shape at lower radial locations, and then elongate towards tangential flow at larger radii.

A key objective of this experiment was to analyze DOSI trends in the novel dishes. Determining DOSI first required determining the principal flow direction. The primary direction was determined by line fitting the vector components in plots like Figures 66 – 95. These plots display the tangential and radial directions for each case of flow in the orbiting dishes. The slope of the trend line produced by linear curve fitting provided a numerical representation of the resultant vector or primary direction for the DOSI calculation. The numerical relationship is beneficial because it provided a simple method for identifying increases or decreases in directional favored flow. This is why the slope trend lines along with the DOSI values were analyzed.

Lastly, DOSI was determined to help identify the degree of oscillation in the novel geometry dishes. Each dish had different DOSI values patterns that varied with orbital speed.
B. NCF Shear Stress Contours

Several observations can be made surrounding the differences in the shear stress contours as orbital speed increases. First, the shear stress magnitude increased as expected with increasing orbital speed. The maximum shear stress increased a full order of magnitude from 2.4 dynes/cm² at 60 RPM to 20 dynes/cm² at 180 RPM in the NCF dish. (These magnitudes can be seen on the contours in APPENDIX B Figures 96 – 100 that display actual shear stress.) Second, the location of the maximum shear shifted as orbital speed increased. Only at the lowest orbital speed did the maximum shear location approach the inner wall. As the orbital speed increased (90, 120, 150, and 180) the maximum shear was pushed outwards, concentrating in the middle of the gap, and a larger portion of the fluid had higher shear (darker orange and red colors).

The dimensionless shear stress contours of the narrow channel flat dish can be seen in Figures 25-29. Similar to the actual shear contours, the dimensionless shear contours for the NCF dish changed as orbital speed increased. At 60 RPM there was concentrated spot of higher dimensionless shear (greater than 0.5) but the majority of dimensionless shear had low values (less than 0.5). As orbital speed increased more of the dimensionless contour values became higher; however, after 120 RPM as the orbital speed continued to increase the dimensionless shear decreased. The increase and then decrease indicates that the viscous favored shear prediction equation (6) worked best at 120 RPM because the 120 RPM case had the largest area of dimensionless shear values close to one. Another observation about the dimensionless shear contours is that in the NCF dishes there is a second region with a magnitude close to half the maximum of the main wave, in each respective speed case. For example, in the NCF 120 RPM case the maximum dimensionless shear was close to 1 while the second region was roughly 0.5. This second region’s area decreased as the orbital speed increased. To examine how dimensionless shear changes based on radial location a plot was prepared as seen in Figure 30. The plot shows the average magnitude of
dimensionless shear experienced at each location and orbital speed. The dimensionless shear averages are clearly less than one. This means Equation 6, the viscous shear equation prediction, is not accurate for determining shear in the NCF dish. For the NCF dish the average dimensionless shear values only ranged from 0.163 to 0.485. Despite the averages not approaching one, a visual inspection of the shear contours showed that the dimensionless shear, in the main fluid wave, did approach one in some places. The reason the viscous shear equation under predicts the magnitude of shear stress is most likely due to wall affects. As stated previously, the viscous favor shear equation is most accurate for flat orbiting planes (no wall affects) with low dimensionless variables. The dimensionless variables for the NCF dish were sufficiently low but had multiple walls. The presence of walls must have constricted fluid flow and decreased the shear stress. Based on the results from the average dimensionless shear values and shear contours, it’s logical to conclude that Equation 6 is not an adequate equation for calculating shear stress in the NCF dish at these conditions.

Another observation surrounding dimensionless shear is shown in Figure 30. For each radii, across all orbital speeds, the average dimensionless shear values remained steady. Figure 30 also helps easily quantify the differences between radial locations. For example, at 120 RPM the maximum variation in dimensionless shear occurred between the 60% location and 10% location with values of 0.485 and 0.163, respectively. This means the average dimensionless shear stress differed by approximately a multiple of three between these two locations. The remaining orbital speeds had smaller but still significant differences in average dimensionless shear among radial locations. The least variation occurred at 60 RPM but still had a maximum difference that was close to a multiple of two. This means that at the parameters run, shear stress varies significantly in the NCF dish.
FIGURE 25 – Narrow Channel Flat Dish Dimensionless Shear Stress Contour 60 RPM (Stokes: 0.06, Slope: 0.12, Froude: 0.18, and Reynolds: 0.01)

FIGURE 26 – Narrow Channel Flat Dish Dimensionless Shear Stress Contour 90 RPM (Stokes: 0.22, Slope: 0.28, Froude: 0.27, and Reynolds: 0.15)
FIGURE 27 – Narrow Channel Flat Dish Dimensionless Shear Stress Contour 120 RPM (Stokes: 0.56, Slope: 0.5, Froude: 0.36, and Reynolds: 1.01)

FIGURE 28 – Narrow Channel Flat Dish Dimensionless Shear Stress Contour 150 RPM (Stokes: 0.76, Slope: 0.78, Froude: 0.45, and Reynolds: 1.89)
FIGURE 29 – Narrow Channel Flat Dish Shear Stress Dimensionless Contour 180 RPM (Stokes: 0.96, Slope: 1.12, Froude: 0.54, and Reynolds: 3.03)

FIGURE 30 – Narrow Channel Flat Dish Average Dimensionless Shear Stress vs RPM
C. **NCF Tangential vs Radial Plots**

For the NCF dish cases the shear stress magnitudes reached a maximum closer to the center of the gap and decreased as the fluid approached the inner and outer wall. This was highlighted in the previous section and here in Figures 31 - 32. This basic trend was consistent at all orbital speeds (as seen in APPENDIX B Figures 66 – 75). The benefit of the tangential vs radial plots are their ability to pinpoint the direction of directional favored flow. In this case the tangential vs radial plots show the important result that the narrow channel flat dish provided uniaxial (tangential) favored shear stress at all radial locations, as opposed to bidirectional flow and tangential flow in conventional dishes, (Thomas (2007)). This was deduced from the elongated plots that stretch in the tangential direction. This characteristic of the narrow channel flat dishes is a key benefit.

**FIGURE 31** – Narrow Channel Flat Dish 150 RPM Graph At 10%, 20, and 40%
FIGURE 32 – Narrow Channel Flat Dish 150 RPM Graph At 60%, 80%, And 90%

D. NCF Trend Line Slopes

An example showing a graphical representation of the trend lines for the NCF dish is displayed in Figure 33, for the 150 RPM case. (All the slope data for each case can be found in APPENDIX B in Table II.) The slopes are identified at only 40%, 80% and 90% locations, which highlight the overall trends while reducing clutter on the graphs. For the NCF dish the absolute values of the slopes, for the specified locations increased from 3.899 to 6.712 to 14.308. This means that the slopes gradually became more vertical as radial location increased. This indicates a progression towards tangential flow with increasing radii. (Note: The actual slope values, which may include negative values, are presented in APPENDIX B while absolute values are used in the Discussion.)
To highlight patterns between orbital speeds, scatter plots were prepared for each geometry. The NCF dish data showed a general increase in slope as speed increased (Figure 34). Furthermore, for a given orbital speed the slope values were at a minimum at the center and increased towards either wall. For example for NCF dish at 120 RPM the values are: 8.25 at 10%, 3.76 at 20%, 3.28 at 40%, 3.81 at 60%, 6.05 at 80%, and 11.64 at 90%.
The NCF dish has less variation in DOSI values within a particular orbital speed, as speed increased. The ranges for NCF’s DOSI values averaged to be 0.26 at 10% and 0.54 at 60% (both of which correspond respectively to the minimum and maximum DOSI values). These values are displayed graphically in Figure 35. The data show that less oscillation between the two primary directions occurred near the center of the narrow channel gap. In past experiments the DOSI values varied with radial location differently (Charkraborty et al. (2011)). In that study, the normal trend increased from ~0 close to the 0% radial location to ~ 1 close to the 100% radial location. This new trend is promising as it proves low variation in oscillation is possible within a dish.
The following were observations made surrounding the differences in the shear stress contours as orbital speed increases. First, the shear stress magnitude increased with increasing orbital speed. The maximum shear stress increased on the order of six times from the lowest orbital speed to the highest orbital speed. The maximum shear stress magnitude was around 6 dynes/cm\(^2\) at 60 RPM and 39 dynes/cm\(^2\) at 180 RPM. (These magnitudes can be seen on the contours in APPENDIX B Figures 101 – 105 that display actual shear stress.). Second, at the lowest orbital speed (60 RPM) the shear reached a maximum at a concentrated spot. As the orbital speed increased (90 RPM, 120 RPM, 150 RPM, and 180 RPM) the concentrated spot extended further back into the following fluid, concentrating along the outer wall.

Dimensionless shear contours for the narrow channel banked bottom dishes are seen in Figures 36 – 40. Similar to the actual shear contours, the dimensionless shear contours for the NCB dish changed depending on the orbital speed. At 60 RPM, 150 RPM, and 180 RPM the contours depict the highest shear as a concentrated spot with the remaining shear at a relatively consistent

![FIGURE 35 – Narrow Channel Flat Dish DOSI vs Location Graph](image-url)
value (green in color). At 90 RPM and 120 RPM an elongated region contained the highest shear. To examine how dimensionless shear changed based on radial location a plot was prepared as seen in Figure 42. On the figure at 90 RPM, 120 RPM, 150RPM, and 180 RPM the average dimensionless shear increases as radial location increases but at the 90% radial location it then decreases to less than the 40% radial location. The reason for this is most likely due to the drying phenomenon. Figure 41 displays phase contours for the NCB dish. These contours show that drying was present and that the amount of dry area increased as orbital speed increased Drying caused shear values to approach zero. The significant area that was dry (shown in Figure 41) causes the average dimensionless shear at the 90% radial location to decrease.

Figure 42 highlights the significant numerical differences in shear between radial locations. For example, at 60 RPM the maximum variation in dimensionless shear occurred between the 40% location and 90% location with an average value of 0.711 and 0.246, respectively. This means the average shear stress differed by approximately a multiple of three between these two locations. The remaining orbital speeds had smaller but still significant differences in average dimensionless shear among radial locations. The least variation occurred at 90 RPM but still had a maximum difference that was close to a multiple of two. This means that at the parameters run, shear stress varies significantly in the NCB dish.

One direct observation about dimensionless shear is that visual inspection of the shear contours showed that the dimensionless shear, in the main fluid wave, regularly exceeded a value of 1.0. The contours max out near a value of 4.0, but the average values in Figure 42 are less than 1.0. Because there is more area of lower shear, it brings the average down. There is a small region near the wall that deviates from Equation 6. Near the wall is where one would expect the greatest deviation. In fact, visually, the dimensionless shear fell close to a value of 1.8 for most of the fluid wave in all cases and reached a maximum value of 4 in the 60 RPM, 90 RPM, 120 RPM and 150
RPM cases. Thus, the viscous shear equation over predicts the magnitude of shear stress. The reason Equation 6 over predicts is most likely due to the centrifugal forces that act on a banked surface instead of parallel to the bottom surface. The additional force would theoretically increase the shear stress on the bottom surface. Based on the results of the average dimensionless shear values being less than one and shear contours fluid wave values being greater than one, it is logical to conclude that the viscous favored shear equation is not an adequate equation for calculating shear stress in the NCB dish at these conditions.
FIGURE 36 – Narrow Channel Banked Dish Dimensionless Shear Stress Contour 60 RPM (Stokes: 0.03, Slope: 0.96, Froude: 0.13, and Reynolds: 0.003)

FIGURE 37 – Narrow Channel Banked Dish Dimensionless Shear Stress Contour 90 RPM (Stokes: 0.12, Slope: 0.91, Froude: 0.19, and Reynolds: 0.04)
FIGURE 38 – Narrow Channel Banked Dish Dimensionless Shear Stress Contour 120 RPM (Stokes: 0.3, Slope: 0.85, Froude: 0.26, and Reynolds: 0.29)

FIGURE 39 – Narrow Channel Banked Dish Dimensionless Shear Stress Contour 150 RPM (Stokes: 0.41, Slope: 0.76, Froude: 0.32, and Reynolds: 0.53)
FIGURE 40 – Narrow Channel Banked Dish Dimensionless Shear Stress Contour 180 RPM (Stokes: 0.52, Slope: 0.66, Froude: 0.39, and Reynolds: 0.86)

FIGURE 41 - Narrow Channel Banked Dish Phase Contour 120 RPM (Left), 60 RPM (Middle), and 180 RPM (Right)
FIGURE 42– Narrow Channel Banked Dish Dimensionless Shear Stress Vs RPM

G. NCB Tangential vs Radial Plots

The tangential vs radial plots for the NCB dishes show uniaxial tangential favored shear stress. This is displayed in the example plots in Figures 43 and 44. Additionally, because this trend is persistent in all NCB cases, APPENDIX B Figures 76 – 85 also show this trend. This characteristic of the narrow channel banked dishes is a benefit because it produces more uniaxial flow as opposed to flow patterns for the conventional dish which is more bidirectional and difficult to characterize.
FIGURE 43 - Narrow Channel Banked Dish 150 RPM At 10%, 20, and 40%

FIGURE 44 - Narrow Channel Banked Dish 150 RPM At 60%, 80%, and 90%
H. NCB Trend Line Slopes

The slope values for the NCB dish are shown for the 150 RPM case in Figures 45. (All the slope data for each case can be found in APPENDIX B in Table II.) The values are identified at only the 40%, 80% and 90% locations. For the NCB dish they increased from 3.445 to 5.663 to 6.974. This indicated a progression towards tangential flow with increasing radii. Scatter plots, displaying slope values against radial location, for the NCB geometry are displayed in Figures 46 (60 and 90 rpm) and 47 (120-180 rpm). The slopes remain relatively flat at 60 and 90 rpm (above the 10% radius). Yet, at orbital speeds greater than 90 RPM, the slope values visually began to increase as radii increased.

FIGURE 45- Narrow Channel Banked Dish 150 RPM At 40%, 80%, and 90%
I. NCB DOSI Vs Location

The ranges for NCB’s DOSI values averaged to be 0.01 at 10% and 0.99 at 90% (both of which correspond respectively to the minimum and maximum DOSI values). Within these ranges the NCB dish created three distinct regions of DOSI (Figure 48). Region one consisted of the 10% to 20% locations, region two was from 40% to 60%, and region three was from 80% to 90%. DOSI
values in the first region remained near zero. DOSI values in the second region constituted a sharp transition between region one and three. DOSI in the third region remained near one.

![Graph showing DOSI vs Location for Narrow Channel Banked Dish with different orbital speeds](image)

**FIGURE 48 – Narrow Channel Banked Dish DOSI vs Location Graph**

**J. Conventional Dish Shear Stress Contours**

Several observations can be made surrounding the differences in the shear stress contours as orbital speed increases. For example, the maximum shear stress increased on the order of 35 times from the lowest orbital speed to the highest. The maximum shear stress magnitude was around 0.6 dynes/cm² at 60 RPM and 22 dynes/cm² at 180 RPM. (These magnitudes can be seen on the contours in APPENDIX B Figures 106 – 110 that display actual shear.) At the lowest orbital speed (60 RPM) the shear stress contour appeared as shown in Figure 106. As the orbital speed increased (90 RPM, 120 RPM, 150 RPM, and 180 RPM) the concentrated region moved toward the outer wall and resembled a crescent. Figure 54 shows that drying is present and the amount of dry area increases from 60 RPM to 180 RPM in the conventional dish. Drying has been present in past experiments when using the conventional dish (Thomas (2007)).
To examine how dimensionless shear changed based on radial location a plot was prepared as seen in Figure 55. The plot shows the average magnitude of dimensionless shear experienced at each location and orbital speed. One obvious observation gathered from Figure 55 is that the dimensionless shear averages did not equal one. This means that a viscous favored shear prediction is not accurate for estimating shear in the conventional dish, as was the case for the two narrow channel dishes. For the conventional dish the average dimensionless shear values only ranged from 0.067 to 0.196. Even a visual inspection of the contours shows that the dimensionless shear, in the main fluid wave, does not approach one. The values in the contours never exceed 0.5. Thus the viscous favor shear prediction equation under predicts the magnitude of shear stress in the conventional dish. The reason it under predicts is most likely due to the wall affects and high dimensionless variables. The equation is only valid with no walls effects and low dimensionless variables.

The variation in shear stress throughout different locations on a conventional dish has been problematic in terms of quantifying cellular responses in such systems. Quantifying the variation is necessary for characterizing fluid flow. Figure 55 shows at 120 RPM the maximum variation in dimensionless shear occurs between the 90% location and 10% location with an average value of 0.196 and 0.083, respectively. This means the average dimensionless shear stress differs by approximately a multiple of two between these two locations at that orbital speed. The maximum differences between two radial locations (meaning the difference between the maximum and minimum values at an orbital speed) are 0.024 for 60 RPM, 0.068 for 90 RPM, 0.113 for 120 RPM, 0.104 for 150 RPM and 0.083 for 180 RPM. However, relative to the other orbital speeds, there is significant less variation in the 60 RPM case.
FIGURE 49 – Conventional Dish Dimensionless Shear Stress Contour 60 RPM Large Scale (Left) And Small Scale (Right) (Stokes: 0.14, Slope: 0.33, Froude: 0.78, and Reynolds: 0.18)

FIGURE 50 – Conventional Dish Dimensionless Shear Stress Contour 90 RPM (Stokes: 0.56, Slope: 0.75, Froude: 1.18, and Reynolds: 2.75)
FIGURE 51 – Conventional Dish Dimensionless Shear Stress Contour 120 RPM (Stokes: 1.45, Froude: 1.57, and Reynolds: 18.36)

FIGURE 52 – Conventional Dish Dimensionless Shear Stress Contour 150 RPM (Stokes: 1.98, Froude: 1.96, and Reynolds: 34.42)
FIGURE 53 – Conventional Dish Dimensionless Shear Stress Contour 180 RPM (Stokes: 2.51, Slope: 3.01, Froude: 2.35, and Reynolds: 55.07)

FIGURE 54 - Conventional Dish Phase Contour 60 RPM (Left), 120 RPM (Middle), and 180 RPM (Right)
FIGURE 55– Conventional Dish Dimensionless Shear Stress Vs RPM

K. Conventional Dish Tangential vs Radial Plots

The conventional dish cases (Figure 56 - 59) show a circular shape at lower radial locations, and then elongate towards the tangential direction at larger radii. This highlights the basic trend observed previously (Charkraborty et al (2011)). As radial location increased, uniaxial tangential flow increased. For the lower orbital speeds (60 RPM and 90 RPM) the shift occurred at higher radii locations (80% to 100%), seen in Figures 56 - 57. At higher orbital speeds (120 RPM, 150 RPM, and 180 RPM) the shift occurred at 10% radii, which can be seen in the Figures 58 – 59. (Addition plots for the conventional dish are displayed in APPENDIX B Figures 86 - 95.)
FIGURE 56 – Narrow Channel Conventional Dish 60 RPM 10% TO 40%

FIGURE 57 – Narrow Channel Conventional Dish 60 RPM 60% TO 90%
FIGURE 58 – Conventional Dish 180 RPM At 10%, 20, and 40%

FIGURE 59 – Conventional Dish 180 RPM At 60%, 80%, And 90%
L. **Conventional Dish Trend Line Slopes**

The slope values for the conventional dish are shown in Figure 60 using 150 RPM as an example case. (All the slope data for each case can be found in APPENDIX B in Table II.) The values are identified at only 40%, 80% and 90% and for the conventional dish the slope values increased from 0.484 to 1.385 to 2.389. The slopes gradually became more vertical as radial location increased, which indicated a progression towards tangential flow with increasing radii. This confirms the conclusions from the previous section. The slope trends for all the conventional dish cases are displayed in Figure 61 as a scatter plot. As seen in Figure 61, it is evident that the slope magnitude increased as radial location increased consistently in all conventional dish cases. An interesting observation is that the slope in conventional dishes increased exponentially. This suggests a strong relationship between slope value and orbital speed at the tested parameters.
FIGURE 60– Conventional Dish 180 RPM At 40%, 80% and 90%

FIGURE 61- Conventional Dish Slope Values VS Radial Location
M. Conventional DOSI Vs Location

The ranges for conventional dish DOSI values averaged to be 0.09 at 10% and 0.74 at 90% (both of which correspond respectively to the minimum and maximum DOSI values). The bi-directionality in conventional dishes created DOSI numbers that are low near the center, which in Figure 62 correspond to the 0% location. Then as the radius and speed increased, shear became more unidirectional, causing DOSI to approach one. This shift is the primary reason conventional dishes are impractical for experimental analysis of cellular responses.

FIGURE 62 – Conventional Dish DOSI vs Location Graph
V. CONCLUSION

There are conclusions or observations that are specific to a particular geometry, all geometries, or solely the narrow channel dishes. These conclusions are only valid within the dimensionless variable ranges found in Table I.

First, the conclusions that pertain to all geometries are: All the geometries have shear stress values generally between 0 and 25 dynes. The different geometries’ shear stress values consistently increase as orbital speed increases. The maximum shear stress values occur closer to the leading edge of the waves. However, the maximum shear stress occur in different regions for each geometry. The NCF reaches a maximum magnitude at ~60% of the radius, NCB at ~80%, and the conventional dish at ~90%. For the dimensionless shear plots NCF reaches a maximum at 120 RPM, NCB at 90 RPM, and conventional dish 120 RPM. There is a general trend that as radial location increases tangential motion becomes stronger in all geometries. Lastly, Equation 6 inaccurately predicts shear in each geometry. In the NCF dish Equation 6 under predicts, in the NCB dish it over predicts, and in the conventional dish it under predicts shear stress.

In the NCF and NCB dishes elongation towards tangential motion starts immediately at the 10% location as opposed to the conventional case that starts more circular at 10% and then became elongated as radial location increased.

In the NCF dish, for a given orbital speed, the slope values are at a minimum at the center and increase towards either wall. There is significant variation in dimensionless shear stress on the bottom surface between radial locations. For example, at 120 RPM the average dimensionless shear stress can vary by a multiple of three. DOSI values show lower variability as orbital speed increased. The ranges for NCF’s DOSI values average to be .21 at 10% and .54 at 60%.
Drying occurs at all orbital speeds in the NCB but more drying occurred as speed increased. There is significant variation in dimensionless shear stress on the bottom surface between radial locations. For example, at 60 RPM the average dimensionless shear stress can vary by a multiple of three. The (tangential vs radial) slope was steady at lower orbital speeds and increased linearly at higher orbital speeds for the NCB dish. The DOSI values average to be .01 at 10% and .96 at 90%, thus increase with increasing radii. Lastly, the DOSI values had a sharp transition. Meaning, DOSI in a region from 10% to 20% remained near zero and DOSI in the other region from 80% to 90% remained near one. The quick transition occurred near the 50% gap length location.

In the conventional dish, drying occurs at all orbital speeds but more drying occurs as speed increased. The conventional dish’s tangential vs radial plots had a circular shape at lower radial locations at all orbital speeds. As speed increased the shape became more elliptical by elongating in the tangential (vertical direction). The circular shape represents the bidirectional shear behavior near the center of dishes. However, as the radial location increase, uniaxial tangential behavior was favored. The (tangential vs radial graph) slope increase exponentially with orbital speed for the conventional cases. Finally, the DOSI values average to be .06 at 10% and .72 at 90% and increase with increasing radial location.

In summary there were several key findings pertaining to the stated objectives that resulted from this work. For the NCF dish the least variation in shear magnitude, between radial locations, occurs at 60 RPM. In terms of the DOSI values, the NCF dish had increasingly higher DOSI values, meaning more uniaxial favored (tangential) flow across the surface of the dish as speed increased. The lowest variation occurred at 180 RPM. For the NCB dish the least variation in shear magnitude, between radial locations, occurred at 90 RPM. The NCB dish’s narrow range of shear stress is hypothesized to be the result of a more parallel fluid surface relative to the bottom surface of the
dish. The NCB dish had DOSI values close to 1.0, meaning more uniaxial favored (tangential) flow, at the 80% and 90% radial locations for speeds between 120 and 180 rpm.
VI. RECOMMENDATIONS

Future studies should analyze the novel geometries by varying the dimensionless parameters individually. Studies should examine different fluid heights since height is a key factor in shear stress magnitude. Other geometries should be studied such as a banked dish with different angles, or non-narrow channel banked bottom dishes. While shear stress in conventional dishes has been experimentally validated with PIV (Particle Image Velocimetry), new geometries may require their own experimental and/or analytical validation.
REFERENCES CITED


APPENDIX A

COMPUTER AND FLUENT PROGRAMS

#include "udf.h"
DEFINE_CG_MOTION(rotor_motion, dt, cg_vel, cg_omega, time, dtime)
{
  real w,angle;
  real offset = 0.;
  real radius = 0.012;
  w = 28.5774;
  NV_S (cg_omega, =, 0.0);
  NV_S (cg_vel, =, 0.0);
  angle = w*time + offset;
  cg_vel[0] = -radius * w * sin(angle);
  cg_vel[1] = radius * w * cos(angle);
}

FIGURE 63 – Example User Defined Function

#!/bin/bash
#PBS -q dualcore2
#PBS -l nodes=1:ppn=1
#PBS -m e
#PBS -M jmthom27@louisville.edu
INPUT_FILE=/scr/JMDT/thesis/stokes/stokes10/inputfile_uss
OUTPUT_FILE=/scr/JMDT/thesis/stokes/stokes10/outputfile
DIM=3d
PROG="/apps/Fluent.Inc/bin/fluent "
PROGARGS="$DIM -g -i $INPUT_FILE"
echo Running on:
  cat $PBS_NODEFILE
  NPROCS=`wc -l < $PBS_NODEFILE`
  echo This job uses $NPROCS processors
hostname

$PROG $PROGARGS > $OUTPUT_FILE 2>&1

FIGURE 64 – Example Batch File
rc /scr/JMDT/thesis/stokes/stokes10/10stokes5.cas
rd /scr/JMDT/thesis/stokes/stokes10/10stokes5.dat
solve
d
859
50
wc /scr/JMDT/thesis/stokes/stokes10/10stokes0864.cas
wd /scr/JMDT/thesis/stokes/stokes10/10stokes0864.dat
quit
exit
yes

FIGURE 65 – Example Input File
APPENDIX B

DATA
FIGURE 66 – Narrow Channel Flat Dish 60 RPM 10% TO 40%

FIGURE 67 – Narrow Channel Flat Dish 60 RPM 60% TO 90%
FIGURE 68 – Narrow Channel Flat Dish 90 RPM 10% TO 40%

FIGURE 69 – Narrow Channel Flat Dish 90 RPM 60% TO 90%
FIGURE 70 – Narrow Channel Flat Dish 120 RPM 10% TO 40%

FIGURE 71 – Narrow Channel Flat Dish 120 RPM 60% TO 90%
FIGURE 72 – Narrow Channel Flat Dish 150 RPM 10% TO 40%

FIGURE 73 – Narrow Channel Flat Dish 150 RPM 60% TO 90%
FIGURE 74 – Narrow Channel Flat Dish 180 RPM 10% TO 40%

FIGURE 75 – Narrow Channel Flat Dish 180 RPM 60% TO 90%
FIGURE 76 – Narrow Channel Banked Dish 60 RPM 10% TO 40%

FIGURE 77 – Narrow Channel Banked Dish 60 RPM 60% TO 90%
FIGURE 78 – Narrow Channel Banked Dish 90 RPM 10% TO 40%

FIGURE 79 – Narrow Channel Banked Dish 90 RPM 60% TO 90%
FIGURE 80 – Narrow Channel Banked Dish 120 RPM 10% TO 40%

FIGURE 81 – Narrow Channel Banked Dish 120 RPM 60% TO 90%
FIGURE 82 – Narrow Channel Banked Dish 150 RPM 10% TO 40%

FIGURE 83 – Narrow Channel Banked Dish 150 RPM 60% TO 90%
FIGURE 84 – Narrow Channel Banked Dish 180 RPM 10% TO 40%

FIGURE 85 – Narrow Channel Banked Dish 180 RPM 60% TO 90%
FIGURE 86 – Narrow Channel Conventional Dish 60 RPM 10% TO 40%

FIGURE 87 – Narrow Channel Conventional Dish 60 RPM 60% TO 90%
FIGURE 88 – Narrow Channel Conventional Dish 90 RPM 10% TO 40%

FIGURE 89 – Narrow Channel Conventional Dish 90 RPM 60% TO 90%
FIGURE 90 – Narrow Channel Conventional Dish 120 RPM 10% TO 40%

FIGURE 91 – Narrow Channel Conventional Dish 120 RPM 60% TO 90%
FIGURE 92 – Narrow Channel Conventional Dish 150 RPM 10% TO 40%

FIGURE 93 – Narrow Channel Conventional Dish 150 RPM 60% TO 90%
FIGURE 94 – Narrow Channel Conventional Dish 180 RPM 10% TO 40%

FIGURE 95 – Narrow Channel Conventional Dish 180 RPM 60% TO 90%
FIGURE 96 – Narrow Channel Flat Dish Shear Stress Contour 60 RPM

FIGURE 97 – Narrow Channel Flat Dish Shear Stress Contour 90 RPM
FIGURE 98 – Narrow Channel Flat Dish Shear Stress Contour 120 RPM

FIGURE 99 – Narrow Channel Flat Dish Shear Stress Contour 150 RPM
FIGURE 100 – Narrow Channel Flat Dish Shear Stress Contour 180 RPM

FIGURE 101 – Narrow Channel Banked Dish Shear Stress Contour 60 RPM
FIGURE 102 – Narrow Channel Banked Dish Shear Stress Contour 90 RPM

FIGURE 103 – Narrow Channel Banked Dish Shear Stress Contour 120 RPM
FIGURE 104 – Narrow Channel Banked Dish Shear Stress Contour 150 RPM

FIGURE 105 – Narrow Channel Banked Dish Shear Stress Contour 180 RPM
FIGURE 106 – Conventional Dish Shear Stress Contour 60 RPM

FIGURE 107 – Conventional Dish Shear Stress Contour 90 RPM
FIGURE 108 – Conventional Dish Shear Stress Contour 120 RPM

FIGURE 109 – Conventional Dish Shear Stress Contour 150 RPM
FIGURE 110 – Conventional Dish Shear Stress Contour 180 RPM
### TABLE II – Slopes Corresponding With Primary Axis Relation To Tangential/Radial Direction

<table>
<thead>
<tr>
<th>Case</th>
<th>RPM</th>
<th>Gap %</th>
<th>Slope</th>
<th>Case</th>
<th>RPM</th>
<th>Gap %</th>
<th>Slope</th>
<th>Case</th>
<th>RPM</th>
<th>Radius %</th>
<th>Slope</th>
</tr>
</thead>
<tbody>
<tr>
<td>Flat</td>
<td>60</td>
<td>10</td>
<td>9.81</td>
<td>Banked</td>
<td>60</td>
<td>10</td>
<td>1.18</td>
<td>Conventional</td>
<td>60</td>
<td>10</td>
<td>-0.08</td>
</tr>
<tr>
<td>Flat</td>
<td>60</td>
<td>20</td>
<td>0.03</td>
<td>Banked</td>
<td>60</td>
<td>20</td>
<td>-5.21</td>
<td>Conventional</td>
<td>60</td>
<td>20</td>
<td>-0.06</td>
</tr>
<tr>
<td>Flat</td>
<td>60</td>
<td>40</td>
<td>-0.84</td>
<td>Banked</td>
<td>60</td>
<td>40</td>
<td>-3.77</td>
<td>Conventional</td>
<td>60</td>
<td>40</td>
<td>-0.11</td>
</tr>
<tr>
<td>Flat</td>
<td>60</td>
<td>60</td>
<td>-0.88</td>
<td>Flat</td>
<td>60</td>
<td>60</td>
<td>-3.06</td>
<td>Conventional</td>
<td>60</td>
<td>60</td>
<td>-0.21</td>
</tr>
<tr>
<td>Flat</td>
<td>60</td>
<td>80</td>
<td>1.89</td>
<td>Banked</td>
<td>60</td>
<td>80</td>
<td>-4.87</td>
<td>Conventional</td>
<td>60</td>
<td>80</td>
<td>-0.18</td>
</tr>
<tr>
<td>Flat</td>
<td>60</td>
<td>90</td>
<td>16.10</td>
<td>Flat</td>
<td>60</td>
<td>90</td>
<td>-4.17</td>
<td>Conventional</td>
<td>60</td>
<td>90</td>
<td>-0.77</td>
</tr>
<tr>
<td>Flat</td>
<td>90</td>
<td>10</td>
<td>-3.41</td>
<td>Banked</td>
<td>90</td>
<td>10</td>
<td>-0.64</td>
<td>Conventional</td>
<td>90</td>
<td>10</td>
<td>0.07</td>
</tr>
<tr>
<td>Flat</td>
<td>90</td>
<td>20</td>
<td>-2.67</td>
<td>Banked</td>
<td>90</td>
<td>20</td>
<td>-5.48</td>
<td>Conventional</td>
<td>90</td>
<td>20</td>
<td>0.13</td>
</tr>
<tr>
<td>Flat</td>
<td>90</td>
<td>40</td>
<td>-2.59</td>
<td>Banked</td>
<td>90</td>
<td>40</td>
<td>-3.67</td>
<td>Conventional</td>
<td>90</td>
<td>40</td>
<td>0.24</td>
</tr>
<tr>
<td>Flat</td>
<td>90</td>
<td>60</td>
<td>-3.50</td>
<td>Banked</td>
<td>90</td>
<td>60</td>
<td>-4.11</td>
<td>Conventional</td>
<td>90</td>
<td>60</td>
<td>0.09</td>
</tr>
<tr>
<td>Flat</td>
<td>90</td>
<td>80</td>
<td>-5.61</td>
<td>Banked</td>
<td>90</td>
<td>80</td>
<td>-4.67</td>
<td>Conventional</td>
<td>90</td>
<td>80</td>
<td>-1.01</td>
</tr>
<tr>
<td>Flat</td>
<td>90</td>
<td>90</td>
<td>-4.90</td>
<td>Banked</td>
<td>90</td>
<td>90</td>
<td>-3.97</td>
<td>Conventional</td>
<td>90</td>
<td>90</td>
<td>-1.84</td>
</tr>
<tr>
<td>Flat</td>
<td>120</td>
<td>10</td>
<td>-8.25</td>
<td>Banked</td>
<td>120</td>
<td>10</td>
<td>-1.67</td>
<td>Conventional</td>
<td>120</td>
<td>10</td>
<td>0.17</td>
</tr>
<tr>
<td>Flat</td>
<td>120</td>
<td>20</td>
<td>-3.76</td>
<td>Banked</td>
<td>120</td>
<td>20</td>
<td>-4.88</td>
<td>Conventional</td>
<td>120</td>
<td>20</td>
<td>0.04</td>
</tr>
<tr>
<td>Flat</td>
<td>120</td>
<td>40</td>
<td>-3.28</td>
<td>Banked</td>
<td>120</td>
<td>40</td>
<td>-3.45</td>
<td>Conventional</td>
<td>120</td>
<td>40</td>
<td>-0.19</td>
</tr>
<tr>
<td>Flat</td>
<td>120</td>
<td>60</td>
<td>-3.81</td>
<td>Banked</td>
<td>120</td>
<td>60</td>
<td>-4.05</td>
<td>Conventional</td>
<td>120</td>
<td>60</td>
<td>-0.61</td>
</tr>
<tr>
<td>Flat</td>
<td>120</td>
<td>80</td>
<td>-6.05</td>
<td>Banked</td>
<td>120</td>
<td>80</td>
<td>-5.66</td>
<td>Conventional</td>
<td>120</td>
<td>80</td>
<td>-1.14</td>
</tr>
<tr>
<td>Flat</td>
<td>120</td>
<td>90</td>
<td>-11.64</td>
<td>Banked</td>
<td>120</td>
<td>90</td>
<td>-6.97</td>
<td>Conventional</td>
<td>120</td>
<td>90</td>
<td>-2.20</td>
</tr>
<tr>
<td>Flat</td>
<td>150</td>
<td>10</td>
<td>-12.95</td>
<td>Banked</td>
<td>150</td>
<td>10</td>
<td>-2.33</td>
<td>Conventional</td>
<td>150</td>
<td>10</td>
<td>-0.15</td>
</tr>
<tr>
<td>Flat</td>
<td>150</td>
<td>20</td>
<td>-5.22</td>
<td>Banked</td>
<td>150</td>
<td>20</td>
<td>-3.73</td>
<td>Conventional</td>
<td>150</td>
<td>20</td>
<td>-0.23</td>
</tr>
<tr>
<td>Flat</td>
<td>150</td>
<td>40</td>
<td>-3.90</td>
<td>Banked</td>
<td>150</td>
<td>40</td>
<td>-3.21</td>
<td>Conventional</td>
<td>150</td>
<td>40</td>
<td>-0.48</td>
</tr>
<tr>
<td>Flat</td>
<td>150</td>
<td>60</td>
<td>-4.26</td>
<td>Banked</td>
<td>150</td>
<td>60</td>
<td>-4.14</td>
<td>Conventional</td>
<td>150</td>
<td>60</td>
<td>-0.88</td>
</tr>
<tr>
<td>Flat</td>
<td>150</td>
<td>80</td>
<td>-6.72</td>
<td>Banked</td>
<td>150</td>
<td>80</td>
<td>-5.79</td>
<td>Conventional</td>
<td>150</td>
<td>80</td>
<td>-1.39</td>
</tr>
<tr>
<td>Flat</td>
<td>150</td>
<td>90</td>
<td>-14.31</td>
<td>Banked</td>
<td>150</td>
<td>90</td>
<td>-5.88</td>
<td>Conventional</td>
<td>150</td>
<td>90</td>
<td>-2.39</td>
</tr>
<tr>
<td>Flat</td>
<td>180</td>
<td>10</td>
<td>-7.15</td>
<td>Banked</td>
<td>180</td>
<td>10</td>
<td>-2.62</td>
<td>Conventional</td>
<td>180</td>
<td>10</td>
<td>-0.09</td>
</tr>
<tr>
<td>Flat</td>
<td>180</td>
<td>20</td>
<td>-4.35</td>
<td>Banked</td>
<td>180</td>
<td>20</td>
<td>-3.44</td>
<td>Conventional</td>
<td>180</td>
<td>20</td>
<td>-0.16</td>
</tr>
<tr>
<td>Flat</td>
<td>180</td>
<td>40</td>
<td>-4.03</td>
<td>Banked</td>
<td>180</td>
<td>40</td>
<td>-3.34</td>
<td>Conventional</td>
<td>180</td>
<td>40</td>
<td>-0.52</td>
</tr>
<tr>
<td>Flat</td>
<td>180</td>
<td>60</td>
<td>-5.08</td>
<td>Banked</td>
<td>180</td>
<td>60</td>
<td>-4.10</td>
<td>Conventional</td>
<td>180</td>
<td>60</td>
<td>-1.00</td>
</tr>
<tr>
<td>Flat</td>
<td>180</td>
<td>80</td>
<td>-7.64</td>
<td>Banked</td>
<td>180</td>
<td>80</td>
<td>-5.86</td>
<td>Conventional</td>
<td>180</td>
<td>80</td>
<td>-1.60</td>
</tr>
<tr>
<td>Flat</td>
<td>180</td>
<td>90</td>
<td>-14.99</td>
<td>Banked</td>
<td>180</td>
<td>90</td>
<td>-8.89</td>
<td>Conventional</td>
<td>180</td>
<td>90</td>
<td>-2.70</td>
</tr>
</tbody>
</table>
### TABLE III – Narrow-Channel Dish Size and Time For Steady State Runs Chart Part 1

<table>
<thead>
<tr>
<th>CASE</th>
<th>Height (mm)</th>
<th>Diameter (bottom- mm)</th>
<th>Angle</th>
<th>Thickness (mm)</th>
<th>Cells Height</th>
<th>Number of Cells (Height)</th>
<th>Cell Gap</th>
<th>Number of Cells (Gap)</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>10</td>
<td>35</td>
<td>90</td>
<td>2.5</td>
<td></td>
<td>0.0005</td>
<td>40</td>
<td>5</td>
</tr>
<tr>
<td>2</td>
<td>20</td>
<td>35</td>
<td>90</td>
<td>2.5</td>
<td>0.0005</td>
<td>40</td>
<td>10</td>
<td>205920</td>
</tr>
<tr>
<td>3</td>
<td>20</td>
<td>35</td>
<td>90</td>
<td>2.5</td>
<td>0.0005</td>
<td>40</td>
<td>15</td>
<td>475480</td>
</tr>
<tr>
<td>4</td>
<td>20</td>
<td>35</td>
<td>90</td>
<td>2.5</td>
<td>0.001</td>
<td>20</td>
<td>5</td>
<td>27200</td>
</tr>
<tr>
<td>5</td>
<td>20</td>
<td>35</td>
<td>90</td>
<td>2.5</td>
<td>0.0005</td>
<td>40</td>
<td>5</td>
<td>54400</td>
</tr>
<tr>
<td>6</td>
<td>20</td>
<td>35</td>
<td>90</td>
<td>2.5</td>
<td>0.001</td>
<td>20</td>
<td>10</td>
<td>102960</td>
</tr>
<tr>
<td>7</td>
<td>20</td>
<td>35</td>
<td>90</td>
<td>2.5</td>
<td>0.0005</td>
<td>40</td>
<td>5</td>
<td>54400</td>
</tr>
<tr>
<td>8</td>
<td>20</td>
<td>35</td>
<td>90</td>
<td>2.5</td>
<td>0.001</td>
<td>20</td>
<td>10</td>
<td>102960</td>
</tr>
<tr>
<td>9</td>
<td>20</td>
<td>35</td>
<td>90</td>
<td>2.5</td>
<td>0.0002</td>
<td>50</td>
<td>5</td>
<td>168600</td>
</tr>
<tr>
<td>10</td>
<td>10</td>
<td>35</td>
<td>90</td>
<td>2.5</td>
<td>0.0002</td>
<td>50</td>
<td>10</td>
<td>307850</td>
</tr>
<tr>
<td>11</td>
<td>10</td>
<td>35</td>
<td>90</td>
<td>2.5</td>
<td>0.0002</td>
<td>50</td>
<td>15</td>
<td>504050</td>
</tr>
<tr>
<td>12</td>
<td>10</td>
<td>35</td>
<td>90</td>
<td>2.5</td>
<td>0.0002</td>
<td>50</td>
<td>15</td>
<td>504050</td>
</tr>
<tr>
<td>13</td>
<td>10</td>
<td>35</td>
<td>90</td>
<td>2.5</td>
<td>0.0003</td>
<td>33.33333</td>
<td>5</td>
<td>73712</td>
</tr>
<tr>
<td>14</td>
<td>10</td>
<td>35</td>
<td>90</td>
<td>2.5</td>
<td>0.0003</td>
<td>33.33333</td>
<td>10</td>
<td>172346</td>
</tr>
<tr>
<td>15</td>
<td>10</td>
<td>35</td>
<td>90</td>
<td>2.5</td>
<td>0.0003</td>
<td>33.33333</td>
<td>15</td>
<td>336804</td>
</tr>
<tr>
<td>16</td>
<td>10</td>
<td>35</td>
<td>90</td>
<td>2.5</td>
<td>0.0015</td>
<td>66.66667</td>
<td>5</td>
<td>308066</td>
</tr>
<tr>
<td>17</td>
<td>10</td>
<td>35</td>
<td>90</td>
<td>2.5</td>
<td>0.0015</td>
<td>66.66667</td>
<td>7</td>
<td>393223</td>
</tr>
<tr>
<td>18</td>
<td>10</td>
<td>35</td>
<td>90</td>
<td>2.5</td>
<td>0.0015</td>
<td>66.66667</td>
<td>9</td>
<td>468263</td>
</tr>
<tr>
<td>19</td>
<td>10</td>
<td>35</td>
<td>90</td>
<td>2.5</td>
<td>0.0003</td>
<td>33.33333</td>
<td>16</td>
<td>466072</td>
</tr>
<tr>
<td>20</td>
<td>10</td>
<td>35</td>
<td>90</td>
<td>2.5</td>
<td>0.0004</td>
<td>25</td>
<td>15</td>
<td>245500</td>
</tr>
<tr>
<td>21</td>
<td>10</td>
<td>35</td>
<td>90</td>
<td>2.5</td>
<td>0.0004</td>
<td>25</td>
<td>19</td>
<td>486425</td>
</tr>
<tr>
<td>22</td>
<td>10</td>
<td>35</td>
<td>90</td>
<td>2.5</td>
<td>0.0005</td>
<td>20</td>
<td>15</td>
<td>194220</td>
</tr>
<tr>
<td>23</td>
<td>10</td>
<td>35</td>
<td>90</td>
<td>2.5</td>
<td>0.0005</td>
<td>20</td>
<td>20</td>
<td>432000</td>
</tr>
<tr>
<td>24</td>
<td>10</td>
<td>35</td>
<td>90</td>
<td>2.5</td>
<td>0.0006</td>
<td>16.66667</td>
<td>5</td>
<td>22797</td>
</tr>
<tr>
<td>25</td>
<td>10</td>
<td>35</td>
<td>90</td>
<td>2.5</td>
<td>0.0006</td>
<td>16.66667</td>
<td>10</td>
<td>83912</td>
</tr>
<tr>
<td>26</td>
<td>10</td>
<td>35</td>
<td>90</td>
<td>2.5</td>
<td>0.00075</td>
<td>13.33333</td>
<td>10</td>
<td>69188</td>
</tr>
<tr>
<td>27</td>
<td>10</td>
<td>35</td>
<td>90</td>
<td>2.5</td>
<td>0.0008</td>
<td>12.5</td>
<td>10</td>
<td>64246</td>
</tr>
<tr>
<td>28</td>
<td>10</td>
<td>35</td>
<td>90</td>
<td>2.5</td>
<td>0.001</td>
<td>10</td>
<td>5</td>
<td>13380</td>
</tr>
<tr>
<td>29</td>
<td>10</td>
<td>35</td>
<td>90</td>
<td>2.5</td>
<td>0.001</td>
<td>10</td>
<td>10</td>
<td>49420</td>
</tr>
<tr>
<td>30</td>
<td>10</td>
<td>35</td>
<td>90</td>
<td>2.5</td>
<td>0.0002</td>
<td>50</td>
<td>5</td>
<td>168600</td>
</tr>
<tr>
<td>31</td>
<td>10</td>
<td>35</td>
<td>90</td>
<td>2.5</td>
<td>0.0003</td>
<td>33.33333</td>
<td>5</td>
<td>73712</td>
</tr>
<tr>
<td>32</td>
<td>10</td>
<td>35</td>
<td>90</td>
<td>2.5</td>
<td>0.0003</td>
<td>33.33333</td>
<td>10</td>
<td>172346</td>
</tr>
<tr>
<td>33</td>
<td>10</td>
<td>35</td>
<td>90</td>
<td>2.5</td>
<td>0.0004</td>
<td>25</td>
<td>15</td>
<td>245500</td>
</tr>
</tbody>
</table>
TABLE IV – Narrow-Channel Dish Size and Time For Steady State Runs Chart Part 2

<table>
<thead>
<tr>
<th>CASE</th>
<th>Bottom Cell Count</th>
<th>RPM</th>
<th>Run Time (Time Steps)</th>
<th>Seconds</th>
<th>Rotations</th>
<th>Max Bottom Shear (dyne/cm²)</th>
<th>Average Bottom Shear Stress (dyne/cm²)</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>120</td>
<td>2000</td>
<td></td>
<td>2</td>
<td>4</td>
<td>2.244463</td>
<td>1.017279</td>
</tr>
<tr>
<td>2</td>
<td>120</td>
<td>2000</td>
<td></td>
<td>2</td>
<td>4</td>
<td>12.08155</td>
<td>3.097948</td>
</tr>
<tr>
<td>3</td>
<td>120</td>
<td>2000</td>
<td></td>
<td>2</td>
<td>4</td>
<td>18.3149</td>
<td>2.757896</td>
</tr>
<tr>
<td>4</td>
<td>120</td>
<td>1750</td>
<td></td>
<td>1.75</td>
<td>3.5</td>
<td>20.50029</td>
<td>2.607605</td>
</tr>
<tr>
<td>5</td>
<td>120</td>
<td>2000</td>
<td></td>
<td>2</td>
<td>4</td>
<td>11.30507</td>
<td>2.088004</td>
</tr>
<tr>
<td>6</td>
<td>120</td>
<td>2000</td>
<td></td>
<td>2</td>
<td>4</td>
<td>15.61587</td>
<td>1.828051</td>
</tr>
<tr>
<td>7</td>
<td>1360</td>
<td>60</td>
<td>2000</td>
<td>2</td>
<td>2</td>
<td>1.852341</td>
<td>0.7793514</td>
</tr>
<tr>
<td>8</td>
<td>11887</td>
<td>60</td>
<td>2000</td>
<td>2</td>
<td>2</td>
<td>2.006745</td>
<td>0.8404718</td>
</tr>
<tr>
<td>9</td>
<td>5148</td>
<td>60</td>
<td>2000</td>
<td>2</td>
<td>2</td>
<td>1.488952</td>
<td>0.6220465</td>
</tr>
<tr>
<td>10</td>
<td>3372</td>
<td>60</td>
<td>4000</td>
<td>4</td>
<td>4</td>
<td>2.14532</td>
<td>0.8758979</td>
</tr>
<tr>
<td>11</td>
<td>6157</td>
<td>60</td>
<td>4000</td>
<td>4</td>
<td>4</td>
<td>2.121403</td>
<td>0.8718316</td>
</tr>
<tr>
<td>12</td>
<td>10081</td>
<td>60</td>
<td>1250</td>
<td>1.25</td>
<td>1.25</td>
<td>4.007246</td>
<td>0.8327431</td>
</tr>
<tr>
<td>13</td>
<td>2211</td>
<td>60</td>
<td>4000</td>
<td>4</td>
<td>4</td>
<td>2.053297</td>
<td>0.8296435</td>
</tr>
<tr>
<td>14</td>
<td>5170</td>
<td>60</td>
<td>4000</td>
<td>4</td>
<td>4</td>
<td>2.124162</td>
<td>0.8856301</td>
</tr>
<tr>
<td>15</td>
<td>10104</td>
<td>60</td>
<td>3000</td>
<td>3</td>
<td>3</td>
<td>2.13615</td>
<td>0.8915288</td>
</tr>
<tr>
<td>16</td>
<td>4621</td>
<td>60</td>
<td>4000</td>
<td>4</td>
<td>4</td>
<td>2.009532</td>
<td>0.839452</td>
</tr>
<tr>
<td>17</td>
<td>5898</td>
<td>60</td>
<td>3000</td>
<td>3</td>
<td>3</td>
<td>2.180534</td>
<td>0.8675869</td>
</tr>
<tr>
<td>18</td>
<td>7024</td>
<td>60</td>
<td>2250</td>
<td>2.25</td>
<td>2.25</td>
<td>2.375</td>
<td>0.8769029</td>
</tr>
<tr>
<td>19</td>
<td>13982</td>
<td>60</td>
<td>2000</td>
<td>2</td>
<td>2</td>
<td>2.516409</td>
<td>0.8923212</td>
</tr>
<tr>
<td>20</td>
<td>9820</td>
<td>60</td>
<td>4000</td>
<td>4</td>
<td>4</td>
<td>2.121051</td>
<td>0.8874801</td>
</tr>
<tr>
<td>21</td>
<td>19457</td>
<td>60</td>
<td>1250</td>
<td>1.25</td>
<td>1.25</td>
<td>2.033</td>
<td>0.7513183</td>
</tr>
<tr>
<td>22</td>
<td>9711</td>
<td>60</td>
<td></td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
</tr>
<tr>
<td>23</td>
<td>21600</td>
<td>60</td>
<td></td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
</tr>
<tr>
<td>24</td>
<td>1368</td>
<td>60</td>
<td>4000</td>
<td>4</td>
<td>4</td>
<td>1.482066</td>
<td>0.5464445</td>
</tr>
<tr>
<td>25</td>
<td>5035</td>
<td>60</td>
<td></td>
<td>4</td>
<td>4</td>
<td>1.58148</td>
<td>0.6016173</td>
</tr>
<tr>
<td>26</td>
<td>5189</td>
<td>60</td>
<td>4000</td>
<td>4</td>
<td>4</td>
<td>1.649635</td>
<td>0.6557856</td>
</tr>
<tr>
<td>27</td>
<td>5140</td>
<td>60</td>
<td></td>
<td>4</td>
<td>4</td>
<td>1.515858</td>
<td>0.547574</td>
</tr>
<tr>
<td>28</td>
<td>1338</td>
<td>60</td>
<td></td>
<td>4</td>
<td>4</td>
<td>1.387642</td>
<td>0.6231371</td>
</tr>
<tr>
<td>29</td>
<td>4942</td>
<td>60</td>
<td></td>
<td>4</td>
<td>4</td>
<td>1.484057</td>
<td>0.6317395</td>
</tr>
<tr>
<td>30</td>
<td>3372</td>
<td>60</td>
<td>4000</td>
<td>4</td>
<td>4</td>
<td>2.14532</td>
<td>0.8758979</td>
</tr>
<tr>
<td>31</td>
<td>2211</td>
<td>60</td>
<td>4000</td>
<td>4</td>
<td>4</td>
<td>2.053297</td>
<td>0.8296435</td>
</tr>
<tr>
<td>32</td>
<td>5170</td>
<td>60</td>
<td>4000</td>
<td>4</td>
<td>4</td>
<td>2.124162</td>
<td>0.8856301</td>
</tr>
<tr>
<td>33</td>
<td>9820</td>
<td>60</td>
<td>4000</td>
<td>4</td>
<td>4</td>
<td>2.121051</td>
<td>0.8874801</td>
</tr>
</tbody>
</table>
**TABLE V – 73712 Cell Narrow Channel Dish Time Step Run**

<table>
<thead>
<tr>
<th>Time Step</th>
<th>Seconds</th>
<th>Rotations</th>
<th>Max Shear</th>
<th>Average Shear</th>
</tr>
</thead>
<tbody>
<tr>
<td>100</td>
<td>0.1</td>
<td>0.1</td>
<td>1.059997</td>
<td>0.5353</td>
</tr>
<tr>
<td>200</td>
<td>0.2</td>
<td>0.2</td>
<td>0.5588</td>
<td>0.214557</td>
</tr>
<tr>
<td>300</td>
<td>0.3</td>
<td>0.3</td>
<td>0.9296</td>
<td>0.4779</td>
</tr>
<tr>
<td>400</td>
<td>0.4</td>
<td>0.4</td>
<td>1.817873</td>
<td>0.92604</td>
</tr>
<tr>
<td>1000</td>
<td>1</td>
<td>1</td>
<td>2.0843</td>
<td>0.9059</td>
</tr>
<tr>
<td>2000</td>
<td>2</td>
<td>2</td>
<td>2.02846</td>
<td>0.82999</td>
</tr>
<tr>
<td>3000</td>
<td>3</td>
<td>3</td>
<td>2.026519</td>
<td>0.8321</td>
</tr>
<tr>
<td>4000</td>
<td>4</td>
<td>4</td>
<td>2.053297</td>
<td>0.829644</td>
</tr>
</tbody>
</table>

**TABLE VI – 168600 Cell Narrow Channel Dish Time Step Run**

<table>
<thead>
<tr>
<th>Time Step</th>
<th>Seconds</th>
<th>Rotations</th>
<th>Max Shear</th>
<th>Average Shear</th>
</tr>
</thead>
<tbody>
<tr>
<td>100</td>
<td>0.1</td>
<td>0.1</td>
<td>1.032</td>
<td>0.54192</td>
</tr>
<tr>
<td>200</td>
<td>0.2</td>
<td>0.2</td>
<td>2.011026</td>
<td>0.638722</td>
</tr>
<tr>
<td>300</td>
<td>0.3</td>
<td>0.3</td>
<td>0.9647</td>
<td>0.499568</td>
</tr>
<tr>
<td>400</td>
<td>0.4</td>
<td>0.4</td>
<td>1.785</td>
<td>0.936</td>
</tr>
<tr>
<td>500</td>
<td>0.5</td>
<td>0.5</td>
<td>1.818</td>
<td>0.821</td>
</tr>
<tr>
<td>1000</td>
<td>1</td>
<td>1</td>
<td>2.101</td>
<td>0.942</td>
</tr>
<tr>
<td>1500</td>
<td>1.5</td>
<td>1.5</td>
<td>2.133</td>
<td>0.923</td>
</tr>
<tr>
<td>2000</td>
<td>2</td>
<td>2</td>
<td>2.092</td>
<td>0.878</td>
</tr>
<tr>
<td>2500</td>
<td>2.5</td>
<td>2.5</td>
<td>2.135</td>
<td>0.91</td>
</tr>
<tr>
<td>3000</td>
<td>3</td>
<td>3</td>
<td>2.077</td>
<td>0.872</td>
</tr>
<tr>
<td>3500</td>
<td>3.5</td>
<td>3.5</td>
<td>2.141</td>
<td>0.907</td>
</tr>
<tr>
<td>4000</td>
<td>4</td>
<td>4</td>
<td>2.145</td>
<td>0.876</td>
</tr>
</tbody>
</table>
### TABLE VII – 172300 Cell Narrow Channel Dish Time Step Run

<table>
<thead>
<tr>
<th>Time Step</th>
<th>Seconds</th>
<th>Rotations</th>
<th>Max Shear</th>
<th>Average Shear</th>
</tr>
</thead>
<tbody>
<tr>
<td>100</td>
<td>0.1</td>
<td>0.1</td>
<td>1.116765</td>
<td>0.53757</td>
</tr>
<tr>
<td>200</td>
<td>0.2</td>
<td>0.2</td>
<td>0.5077</td>
<td>0.22253</td>
</tr>
<tr>
<td>300</td>
<td>0.3</td>
<td>0.3</td>
<td>1.064679</td>
<td>0.478656</td>
</tr>
<tr>
<td>400</td>
<td>0.4</td>
<td>0.4</td>
<td>1.902843</td>
<td>0.92941</td>
</tr>
<tr>
<td>500</td>
<td>0.5</td>
<td>0.5</td>
<td>1.766</td>
<td>0.835</td>
</tr>
<tr>
<td>1000</td>
<td>1</td>
<td>1</td>
<td>2.133</td>
<td>0.949</td>
</tr>
<tr>
<td>2000</td>
<td>2</td>
<td>2</td>
<td>2.106</td>
<td>0.883</td>
</tr>
<tr>
<td>3000</td>
<td>3</td>
<td>3</td>
<td>2.106</td>
<td>0.887</td>
</tr>
<tr>
<td>4000</td>
<td>4</td>
<td>4</td>
<td>2.124</td>
<td>0.886</td>
</tr>
</tbody>
</table>

### TABLE VIII – 245500 Cell Narrow Channel Dish Time Step Run

<table>
<thead>
<tr>
<th>Time Step</th>
<th>Seconds</th>
<th>Rotations</th>
<th>Max Shear</th>
<th>Average Shear</th>
</tr>
</thead>
<tbody>
<tr>
<td>100</td>
<td>0.1</td>
<td>0.1</td>
<td>1.1206</td>
<td>0.51933</td>
</tr>
<tr>
<td>200</td>
<td>0.2</td>
<td>0.2</td>
<td>0.54198</td>
<td>0.24132</td>
</tr>
<tr>
<td>300</td>
<td>0.3</td>
<td>0.3</td>
<td>1.0939</td>
<td>0.42151</td>
</tr>
<tr>
<td>1000</td>
<td>1</td>
<td>1</td>
<td>2.1394</td>
<td>0.950416</td>
</tr>
<tr>
<td>2000</td>
<td>2</td>
<td>2</td>
<td>2.11015</td>
<td>0.88671</td>
</tr>
<tr>
<td>3000</td>
<td>3</td>
<td>3</td>
<td>2.10644</td>
<td>0.884751</td>
</tr>
<tr>
<td>4000</td>
<td>4</td>
<td>4</td>
<td>2.12105</td>
<td>0.88748</td>
</tr>
</tbody>
</table>
### TABLE IX – Dimensionless Parameter Variables

<table>
<thead>
<tr>
<th>Dish</th>
<th>RPM</th>
<th>R</th>
<th>a</th>
<th>( \omega )</th>
<th>g</th>
<th>H</th>
<th>p</th>
<th>V</th>
<th>u</th>
</tr>
</thead>
<tbody>
<tr>
<td>NCF</td>
<td>60</td>
<td>0.0095</td>
<td>0.0025</td>
<td>6.2832</td>
<td>9.81</td>
<td>.000769</td>
<td>997.3</td>
<td>1.194195</td>
<td>.0157</td>
</tr>
<tr>
<td></td>
<td>90</td>
<td>0.0095</td>
<td>0.0025</td>
<td>9.4248</td>
<td>9.81</td>
<td>.000769</td>
<td>997.3</td>
<td>0.119478</td>
<td>.0235</td>
</tr>
<tr>
<td></td>
<td>120</td>
<td>0.0095</td>
<td>0.0025</td>
<td>12.5664</td>
<td>9.81</td>
<td>.000769</td>
<td>997.3</td>
<td>0.023896</td>
<td>.0314</td>
</tr>
<tr>
<td></td>
<td>150</td>
<td>0.0095</td>
<td>0.0025</td>
<td>15.7080</td>
<td>9.81</td>
<td>.000769</td>
<td>997.3</td>
<td>0.015931</td>
<td>.0392</td>
</tr>
<tr>
<td></td>
<td>180</td>
<td>0.0095</td>
<td>0.0025</td>
<td>18.8496</td>
<td>9.81</td>
<td>.000769</td>
<td>997.3</td>
<td>0.011948</td>
<td>.0471</td>
</tr>
<tr>
<td>NCB</td>
<td>60</td>
<td>0.0095</td>
<td>0.0025</td>
<td>6.2832</td>
<td>9.81</td>
<td>.000414</td>
<td>997.3</td>
<td>1.194195</td>
<td>.0157</td>
</tr>
<tr>
<td></td>
<td>90</td>
<td>0.0095</td>
<td>0.0025</td>
<td>9.4248</td>
<td>9.81</td>
<td>.000414</td>
<td>997.3</td>
<td>0.119478</td>
<td>.0235</td>
</tr>
<tr>
<td></td>
<td>120</td>
<td>0.0095</td>
<td>0.0025</td>
<td>12.5664</td>
<td>9.81</td>
<td>.000414</td>
<td>997.3</td>
<td>0.023896</td>
<td>.0314</td>
</tr>
<tr>
<td></td>
<td>150</td>
<td>0.0095</td>
<td>0.0025</td>
<td>15.7080</td>
<td>9.81</td>
<td>.000414</td>
<td>997.3</td>
<td>0.015931</td>
<td>.0392</td>
</tr>
<tr>
<td></td>
<td>180</td>
<td>0.0095</td>
<td>0.0025</td>
<td>18.8496</td>
<td>9.81</td>
<td>.000414</td>
<td>997.3</td>
<td>0.011948</td>
<td>.0471</td>
</tr>
<tr>
<td>Conventional</td>
<td>60</td>
<td>0.0095</td>
<td>0.0175</td>
<td>6.2832</td>
<td>9.81</td>
<td>0.002</td>
<td>997.3</td>
<td>1.194195</td>
<td>.1099</td>
</tr>
<tr>
<td></td>
<td>90</td>
<td>0.0095</td>
<td>0.0175</td>
<td>9.4248</td>
<td>9.81</td>
<td>0.002</td>
<td>997.3</td>
<td>0.119478</td>
<td>.1649</td>
</tr>
<tr>
<td></td>
<td>120</td>
<td>0.0095</td>
<td>0.0175</td>
<td>12.5664</td>
<td>9.81</td>
<td>0.002</td>
<td>997.3</td>
<td>0.023896</td>
<td>.2199</td>
</tr>
<tr>
<td></td>
<td>150</td>
<td>0.0095</td>
<td>0.0175</td>
<td>15.7080</td>
<td>9.81</td>
<td>0.002</td>
<td>997.3</td>
<td>0.015931</td>
<td>.2748</td>
</tr>
<tr>
<td></td>
<td>180</td>
<td>0.0095</td>
<td>0.0175</td>
<td>18.8496</td>
<td>9.81</td>
<td>0.002</td>
<td>997.3</td>
<td>0.011948</td>
<td>.3298</td>
</tr>
</tbody>
</table>

### TABLE X – Average Dimensionless Shear Stress Experienced In Each Radial Location

<table>
<thead>
<tr>
<th>Dish</th>
<th>RPM</th>
<th>10%</th>
<th>20%</th>
<th>40%</th>
<th>60%</th>
<th>80%</th>
<th>90%</th>
</tr>
</thead>
<tbody>
<tr>
<td>NCF</td>
<td>60</td>
<td>0.220</td>
<td>0.323</td>
<td>0.393</td>
<td>0.388</td>
<td>0.308</td>
<td>0.206</td>
</tr>
<tr>
<td></td>
<td>90</td>
<td>0.172</td>
<td>0.253</td>
<td>0.366</td>
<td>0.448</td>
<td>0.353</td>
<td>0.220</td>
</tr>
<tr>
<td></td>
<td>120</td>
<td>0.163</td>
<td>0.265</td>
<td>0.414</td>
<td>0.485</td>
<td>0.403</td>
<td>0.257</td>
</tr>
<tr>
<td></td>
<td>150</td>
<td>0.166</td>
<td>0.282</td>
<td>0.419</td>
<td>0.461</td>
<td>0.385</td>
<td>0.249</td>
</tr>
<tr>
<td></td>
<td>180</td>
<td>0.186</td>
<td>0.290</td>
<td>0.393</td>
<td>0.424</td>
<td>0.357</td>
<td>0.236</td>
</tr>
<tr>
<td>NCB</td>
<td>60</td>
<td>0.308</td>
<td>0.536</td>
<td>0.711</td>
<td>0.697</td>
<td>0.412</td>
<td>0.246</td>
</tr>
<tr>
<td></td>
<td>90</td>
<td>0.279</td>
<td>0.474</td>
<td>0.641</td>
<td>0.693</td>
<td>0.654</td>
<td>0.473</td>
</tr>
<tr>
<td></td>
<td>120</td>
<td>0.253</td>
<td>0.414</td>
<td>0.584</td>
<td>0.636</td>
<td>0.644</td>
<td>0.495</td>
</tr>
<tr>
<td></td>
<td>150</td>
<td>0.231</td>
<td>0.380</td>
<td>0.592</td>
<td>0.626</td>
<td>0.664</td>
<td>0.580</td>
</tr>
<tr>
<td></td>
<td>180</td>
<td>0.225</td>
<td>0.382</td>
<td>0.603</td>
<td>0.587</td>
<td>0.624</td>
<td>0.546</td>
</tr>
<tr>
<td>Conventional</td>
<td>60</td>
<td>0.067</td>
<td>0.065</td>
<td>0.063</td>
<td>0.058</td>
<td>0.049</td>
<td>0.043</td>
</tr>
<tr>
<td></td>
<td>90</td>
<td>0.117</td>
<td>0.115</td>
<td>0.109</td>
<td>0.100</td>
<td>0.135</td>
<td>0.168</td>
</tr>
<tr>
<td></td>
<td>120</td>
<td>0.083</td>
<td>0.098</td>
<td>0.114</td>
<td>0.141</td>
<td>0.175</td>
<td>0.196</td>
</tr>
<tr>
<td></td>
<td>150</td>
<td>0.091</td>
<td>0.088</td>
<td>0.095</td>
<td>0.133</td>
<td>0.179</td>
<td>0.191</td>
</tr>
<tr>
<td></td>
<td>180</td>
<td>0.102</td>
<td>0.099</td>
<td>0.079</td>
<td>0.111</td>
<td>0.156</td>
<td>0.162</td>
</tr>
</tbody>
</table>
Jonathan Lawrence Lambert Jones was born on June 25, 1989 in Schenectady, New York. He lived in Paducah, Kentucky throughout his life until attending undergraduate school at the University of Louisville. After receiving his bachelor’s Degree in Chemical Engineering in 2013 he continued working on his Chemical Engineering Masters as he worked for DuPont in Belle, WV.